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Using Help

The following information explains basic features of a Help topic (this screen is a Help 
topic).

Pop-up definitions are dot-underlined, colored words and phrases that you click to see a 
"pop-up" window that displays information. The pop-ups below explain the buttons on the 
top of this Help screen, and are examples of the pop-ups found in Help. Click once to read 
them, then click again to close them.

Contents
Search
Back
History
Print
Close

Jump terms are underlined, colored words and phrases that move you to another Help 
topic. To read the topic about Context-sensitive Help, click this jump term:    context-
sensitive Help, then click the Back button to return to this Help topic.

The light bulb is an icon 
containing a hint. Click the 
light bulb to read the hint.

Text following a route icon 
shows the menus and buttons 
you choose to access a 
feature.

Text following an exclamation 
point is important information.

Text following a reference icon
directs you to the printed 
documentation.

Many Help topics contain graphics you can click to display a pop-up definition.



Search

Help, Search for Help On

Purpose
Use Search to find topics by feature name or keyword.

Steps

1 Choose Search for Help On from the Help menu.

Choose the Search button in the Help screen.

2 Type or select the word or phrase you want to search for.

3 Double-click a term from the list of terms.

Choose Show Topics.

4 Double-click an item from the list of topics.

Select the topic you want to view, then choose Go To.

See Also
Using Help



Close button
A Help button you can use to close the Help window.



Help Menu

Purpose
Use the options on the Help menu to access online Help for information about how your 
application works.

Contents
Search for Help On
How Do I



Macro Facility Options

Macro Facility, Options

Purpose
Choose Macro Facility Options to read or change the macro options.

Steps

1 Choose Options from the Settings menu in the Macro Facility.

2 Choose a format in which to save your macro.

3 Select Named parameters required to specify named parameters.

4 Select the number of parameters for each line in your macro.

5 Specify a maximum line length for your macro text.

6 Specify a default macro directory.

7 Choose a macro file extension. The default is .WCM.

8 Specify the command line of the Macro Editor you want to use.

9 Choose a macro format for the editor.

10 Choose OK to save your changes.

See Also
Macro Facility
Macro Facility Settings



ODMA Support

Purpose
ODMA (Open Document Management API) lets you use other ODMA-supporting document 
management systems you have installed instead of WordPerfect's file management dialog.

Steps
To use a WordPerfect file management dialog,
1 Request a WordPerfect file management dialog box from the current document 

management system.

To return to your document management system,
1 Open a WordPerfect file management dialog box.

2 Choose the appropriate button.

See Also
Managing Files



Spell Checker QuickCorrect

Spell Checker, QuickCorrect

Purpose
QuickCorrect allows the application you are using to automatically replace misspelled or 
mistyped words with correct ones, and to expand abbreviations as you type. Use 
QuickCorrect inside Spell Checker to add a word and its replacement to the correction list.

Steps

1 Open Spell Checker in the document or text entry box you want to spell-check.

2 Select the options you want to use from the Check, Dictionaries, and Options menus.

3 Choose Add, then select the supplementary dictionary you want to add words and 
phrases to.

4 Choose Start to begin the spell-check.

5 Select or type the word you want to replace the misspelled word with wherever it 
appears, then choose QuickCorrect.

See Also
Spell Checker Add Word/Phrase



 route
The path that indicates where a feature is found. The hand icon points to the steps you take 
to access the feature.



jump term
A graphic or underlined, colored word or phrase you can choose to go to a related Help topic.



Open a Copy of a File

Purpose
Use Open As Copy to open a document as a read-only copy. You can read the document 
and make changes to it, but you must save it with a different filename.

Steps

1 Choose Open from the File menu, then select Open As Copy.

2 Specify the filename you want, then choose Open.

3 Read the file or make changes to it.

4 Choose Save As from the File menu, type a new name for the file, then choose Save.

See Also
Opening Files



Locating Applications

Macro Facility, Play, Locate

Purpose
When you play a macro, the Macro Facility checks the BIF file for the path to the 
application's .exe. If the location is not in the .BIF, Macro Facility asks you to specify the 
location of the application's .exe.

Steps

1 From the Macro Facility, choose Play File macro from the Macros menu.

2 Select the macro you want to play, then choose Play.

3 Specify the location of the .exe file for the application.

4 Choose OK.

See Also
Select Directory



Context-Sensitive Help

Purpose
Use Shift+F1 or F1 to get context-sensitive Help in a dialog box, menu, or window. 
Shift+F1 requires a mouse and provides more specific help than F1.

Steps
To use Shift+F1,
1 Press Shift+F1 in a dialog box, menu, or window.

2 Click the item or control you want information about.

To use F1,
1 Press F1 while a menu item is highlighted or when a dialog box or window is open.
or
Choose the Help button in a dialog box.

See Also
Using Help



 Hint
Find allows you to use multiple wildcard characters (* and ?) in your search string.



Assign Characters to Keys

Purpose
Use the Keyboard Editor and the Characters feature to assign characters in other 
alphabets to combinations of keys (such as A+Alt) on your keyboard.

Steps

1 Choose Preferences from the Edit menu, then choose Keyboard.

2 Select the existing keyboard layout you want to add the characters to, then choose Edit.
or
Choose Create, type a name for the new keyboard layout, then choose OK.

3 Click in the list of possible key combinations, then select the key combination you want 
to assign to a character by scrolling or typing the letter.

4 Select Play a Keyboard Script, then click in the text box.

5 Press Ctrl+W to bring up the Characters dialog box.

6 Choose the character set you want to use, then select the character you want to assign.

7 Choose Insert and Close.

8 Choose Assign Script.

9 Choose OK, choose Select to use the new keyboard layout, then choose Close.

See Also
WordPerfect Characters



Expand Word Searches

QuickFinder, Concepts

Purpose
Use Concept Builder to expand your QuickFinder searches by including alternative forms 
of words such as conjugations, synonyms, and other spellings.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box.

2 Type the word(s) you want to Search For, then choose Concepts.

3 Select the search term for which you want to include alternate words.

4 Choose from the following options:
Word Forms
Thesaurus
Thes. -> Word Forms
Typo
Phonetic

5 Select the original or alternative words you do not want to use and choose Disable. 
(Select disabled words and choose Enable to include them again.)

6 Choose OK to include the enabled alternative words in the search.

7 Choose Find to begin the search including the alternative words.

See Also
QuickFinder
QuickFinder Search For
QuickFinder Search In
Refine QuickFinder Searches



About BIF Edit

BIF Edit, Help, About BIF Edit

Purpose
The WordPerfect BIF Editor is an application you can use as a network administrator to set 
and edit groups, sections, and items in a public or private .BIF file.

Use About BIF Edit to see the BIF Edit logo, the version number, and the release date.

            The BIF Editor is provided for use in editing and flagging Binary Initialization 
File (BIF) settings. The BIF Editor is intended for use by network supervisors and 
administrators and it is suggested that the editor is not made available for general use 
by end users.

Steps

1 Choose About BIF Edit from the Help menu.

See Also
BIF Edit



Select Directory

Purpose
Use the folder icon to select the directory you want. It appears next to text boxes where 
you need to specify a directory name. When you choose OK, the directory you selected 
appears in the text box.

Steps

1 Click the folder icon.

2 Select the drive and directory you want to list the files in.
or
Choose a QuickList entry.

3 Choose OK.



Filename

Purpose
Use the Filename text box to specify the file you want. You can type in the full pathname 
of a file, or select it from the list of files in the current directory. You can also use the 
History list to access a list of previously opened files or selected directories.

Steps
To select a particular filename,
1 In a directory dialog box, select the drive and directory you want to list the files in.
or
Choose a QuickList entry.

2 Specify the name of the file you want to open, select or save.

3 Choose OK.
or
Right-click on the files list, then choose the option you want.

To select a previously selected filename or directory,
1 In a directory dialog box, click the arrow to the right of the Filename text box.

2 Select the name of the file you want to open, or the directory you want to use.

3 Choose OK.

See Also
Directories List
Drives
File List
File Options
QuickList



List Files of Type

Purpose
Use the List Files of Type drop-down list to choose the type of files you want to display. For 
example, choosing Text Files (*.txt) displays all the files in the current directory with a .TXT
extension.

Steps

1 In a directory dialog box, choose the file type you want to display in the file list.

See Also
Directories List
Drives
File List
QuickList
Save File As Type



Drives

Purpose
Use the Drives drop-down list to choose the drive in which you want to list directories and 
files.

Steps

1 In a directory dialog box, choose the drive you want.

See Also
Directories List
File List
QuickList



File List

Purpose
Use the file list box to view the files in the currently selected drive and directory, and to 
select the files you want to use.

Steps

1 In a directory dialog box, select the type of files you want to list.

2 Select the drive and directory whose files you want to list.
or
Select a QuickList item.

3 Select the file(s) you want.

4 Choose OK.
or
Right-click on the files list, then select the option you want.

See Also
Directories List
Drives
File List Display
File Options
List Files of Type
QuickList
Save File As Type



QuickList

Purpose
Use the QuickList to access directories or files without entering the full path every time. 
Use the QuickList options to change the default directory display in your directory dialog 
boxes and to edit your QuickList.

Steps
To display the QuickList,
1 Enter any directory dialog box, then choose QuickList.

2 Choose Show QuickList, Show Directories, or Show Both.

To use the QuickList,
1 Select the QuickList item you want.

2 Select the file(s) you want.

3 Choose OK.
or
Right-click on the files list, then select the option you want.

See Also
Add or Edit QuickList Item
Delete QuickList Item
Print Lists
Open/Save As Setup



Viewer

Purpose
Use the Viewer to display, print, or play files without retrieving them into the document 
window.

Steps

1 Enter any directory dialog box or QuickFinder search results list, then select a file from 
the file list.

2 Choose View.

3 Right-click on the Viewer window, then select an option from the QuickMenu to use 
Viewer features.

4 Choose Close from the Control menu to exit the Viewer.

See Also
Additional Information about Viewer
Viewer Info
Viewing Files



File Options

Purpose
Use the File Options pop-up list to choose options you want to perform on the selected 
file(s) or directory.

Steps

1 In a directory dialog box, select the file(s) you want to affect. 

2 Choose File Options, then choose from the following options:
Copy
Move
Rename
Delete
Change Attributes
Print
Print File List
Create Directory
Remove Directory
Rename Directory



Directories List

Purpose
Use the Directories list box to view a list of directories and subdirectories in a selected 
drive and to select the directory you want to use.

Steps

1 In a directory dialog box, select a drive from the Drives drop-down list, then double-click
directory names to list their subdirectories.

 
2 Double-click a directory name to select that directory and display the names of the files 

in it.

3 Right-click on the Directories list, then choose Create Directory to create a subdirectory 
within a selected directory.
or
Choose Remove Directory to remove the selected directory.

See Also
Create Directory
Drives
File Options
Print Lists
QuickList
Remove Directory



Sorting Files

Open/Save As Setup, Sort By and Sort Order

Purpose
Use Sort By to sort filenames in the files list box by filename, extension, size, date/time, 
descriptive name, or descriptive type. Use Sort Order to specify an ascending or 
descending order.

Steps

1 Enter any directory dialog box, then choose Setup.

2 Select a Sort By option.

3 Select a Sort Order.

4 Choose OK.

See Also
Create Speedup Files
File List Display
Open/Save As Setup



File List Display

Open/Save As Setup, File List Display

Purpose
Use File List Display to specify which elements of a file's description will display in the file 
list box.

Steps

1 Enter any directory dialog box, then choose Setup.

2 Select a Show option.

3 Select Show Column Labels if you want to display headings for Custom Columns.

4 Select Show Hidden/System Files if you want to display hidden and system files.

5 Select Change Default Directory to change the default directory every time you move to
a new directory.

6 Choose OK.

See Also
Create Speedup Files
Open/Save As Setup
Sorting Files



Create Speedup Files

Open/Save As Setup, Create Speedup Files

Purpose
Use Create Speedup Files to make files display faster when you are displaying Document 
Summary information (descriptive name and type) in the file list.

Steps

1 Enter any directory dialog box, then choose Setup.

2 Select Custom Columns or Descriptive Name, Filename.

3 Select Create Speedup Files.

4 Specify a directory to store the speedup files.

5 If the directory specified does not exist, choose Yes to create the directory.

See Also
File List Display
Open/Save As Setup
Sorting Files



Word Forms
Includes conjugations, plurals, adjective, and adverb forms of the selected word in the 
search.



Save File As Type

Purpose
Use the Save File As Type drop-down list to choose the format of the file you want to save.

Steps

1 In a directory dialog box, select the drive and directory where you want to save your 
file.

2 Specify the name of the file you want to save.

3 Choose the format you want.

4 Choose OK to save the file in the selected format.

See Also
Directories List
Drives
Filename
File List
QuickList
Save Format



QuickFinder Search For

QuickFinder, Search For

Purpose
Use Search For to specify the word string or word pattern you want QuickFinder to find.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, type a word or phrase to 
search for.

2 Choose Operators, then choose options to refine your search.

3 Choose Concepts, choose the words you want to include, then choose OK.

4 Specify a File Pattern and choose a Search In option to add further search criteria.

5 Choose Find.

See Also
Expand Word Searches
QuickFinder
QuickFinder Search In
Refine QuickFinder Searches



QuickFinder

Purpose
Use QuickFinder to search for specific files by file pattern, words or phrases, summary 
fields (such as descriptive name, abstract, or typist), date range, or QuickFinder (full-text) 
index. QuickFinder indexes are full-text indexes of all the words in a collection of 
documents.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, then specify your search 
criteria.

2 Type a file pattern to search for.

3 Type a text string to search for.

4 Choose a Search In option.

5 Select WordPerfect Documents Only to limit the search to documents in WordPerfect 
5.0/5.1/5.2/6.0 format.

6 Specify a From date and To date to specify files whose DOS revision date falls within a 
date range.

7 Choose Find to obtain a list of filenames that match your search criteria. The Search 
Results List displays all matching filenames.

Choose from the following options for more information:
File Pattern
Search For
Search In
Concepts
Operators
Options

See Also
Additional Information about QuickFinder
Expand Word Searches
QuickFinder Indexer
QuickFinder Indexer Preferences



Create or Edit Index Criteria

QuickFinder, Indexer, Create or Edit

Purpose
Use QuickFinder Indexer to create and edit indexing criteria (the directories, files, or 
indexing options included in your index) and to generate QuickFinder indexes for quick 
searches. QuickFinder indexes are full-text indexes of all the words in a collection of 
documents.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, then choose Indexer.

2 Choose Create, type a name for the index, then choose OK.
or
Select the name of the index you want to edit, then choose Edit.

3 Type the name of the directory or file you want to add.
or
Choose Browse to display a list of files and directories, then select the directories you 
want to index, then choose Add. Select the directories you do not want to index, then 
choose Remove.

4 Select Include Subtree to include all subdirectories.

5 Choose Options to set individual indexing preferences. 

6 Choose Generate to create the index.

If you are editing an index, indicate if you want to regenerate the entire index or update
the index with new or modified files, then choose OK.

7 From QuickFinder, enter search criteria, then choose Find to search the newly created 
index.

Choose the following option for more information:
Options

See Also
Add Directory or File
Index Name
QuickFinder
QuickFinder Indexer



Viewing Files

Viewer, select a file

Purpose
Use the Viewer to display, print, or play the contents of text, graphics, audio-visual, sound,
cursor, icon, and fax files. The Viewer may not show all formatting exactly as it appears in 
the file.

Steps

1 Enter any directory dialog box or QuickFinder search results list, then select a file from 
the file list.

2 Choose View.

Use the controls in the Viewer to play, stop, reset, fast forward, rewind, or move to the 
beginning or end of audio-visual or sound file.

3 To use features supported by the Viewer, right-click inside the Viewer window, then 
select an option from the QuickMenu. The QuickMenu will change, depending on what 
type of file you are viewing.
Copy to Clipboard
Document Summary
Document Text
Find
Find Next
Find Previous
Font
Go To Page
Graphic Conversion
Hex Display
Invert
Next Page
Previous Page
Print
Remove Highlights
Rotate
Viewer Info
Word Wrap
Zoom

4 Choose Close from the Viewer Control menu to exit the Viewer.

See Also
Printing from the Viewer
Viewer Info



Delete Index

QuickFinder, Indexer, Options, Delete

Purpose
Use Delete Index to delete an existing QuickFinder index.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, choose Indexer, then 
select the index you want to delete.

2 Choose Options, choose Delete, then choose Yes.

See Also
QuickFinder
QuickFinder Indexer



QuickFinder Document Summary Fields

QuickFinder, Options, Summary Fields

Purpose
Use Summary Fields to display and search a list of document summary fields. Only 
WordPerfect 5.0/5.1/5.2/6.0-level documents that contain document summary information 
will be found.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, choose Options, then 
choose All Summary Fields to expand the dialog box to display all possible document 
summary fields.
or
Choose Default Summary Fields to display a selected set of summary fields.

2 Specify the text, numbers, or dates you want to find.

3 Specify additional searching criteria such as file patterns, phrases, or date ranges.

4 Choose Find to perform the search.

See Also
Expand Word Searches
QuickFinder
QuickFinder Options
Refine QuickFinder Searches



Clear

QuickFinder, Options, Clear

Purpose
Use Clear to remove all present QuickFinder search criteria, including all document 
summary fields scrolled off-screen (if the dialog has been expanded using Default 
Summary Fields or All Summary Fields under Options).

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, choose Options, then 
choose Clear.

See Also
QuickFinder
QuickFinder Options
QuickFinder Document Summary Fields



Thesaurus
Includes synonyms of the selected word from the Thesaurus list in the search.



Thes. -> Word Forms
Includes conjugations, plurals, adjective, and adverb forms of the synonyms of the selected 
word in the search.



Typos
Includes possible misspellings and typos of the selected word in the search, and words the 
selected word might be a misspelling or typo for.



QuickFinder File Pattern

QuickFinder, File Pattern

Purpose
Use File Pattern to find files with filenames that contain characters or extensions in 
common. You can specify multiple directories or file patterns in this field.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, type a file pattern. Use 
wildcards to help define the pattern.

2 Type a word string to Search For, along with any operators you want.

You may specify additional search criteria in any of the QuickFinder fields, such as 
Search For and Date Range.

3 Choose Find to perform the search.

See Also
QuickFinder
QuickFinder Search For
QuickFinder Search In



Thesaurus Change Dictionary

Thesaurus, Dictionary, Change Dictionary

Purpose
Use Change Dictionary to access a different Thesaurus dictionary. The main Thesaurus file 
has a .THS extension. Thesaurus dictionaries are available in several languages. If you 
mark the language of text in a document and if you install the correct Thesaurus file for 
that language, WordPerfect accesses the corresponding Thesaurus.

Steps

1 From Thesaurus, choose Change Dictionary from the Dictionary menu.

2 Specify the dictionary you want to use.

3 Choose Select.

See Also
Thesaurus Look Up



QuickFinder Search In

QuickFinder, Search In

Purpose
Use Search In to specify which drives, directories, or indexes you want to search for files.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, choose a Search In option.

If you selected QuickFinder Index, select the index you want to search from. Information 
about the index appears on the next line of the dialog box.

If you selected Disk, choose the disk you want to search.

2 Specify your search criteria in the Search For, File Pattern, Date Range, or Document 
Summary fields, then choose Find.

See Also
QuickFinder
QuickFinder Search For



Copy
Copies selected text from the Word text box to the Clipboard without removing the selection 
from the text box. The selection remains on the Clipboard until you use Cut or Copy to    
replace it with a new selection, or until you exit Windows.



Cut
Removes selected text from the Word text box to the Clipboard. The selection remains on 
the Clipboard until you use Cut or Copy to    replace it with a new selection, or until you exit 
Windows.



Phonetic
Includes phonetic spellings that sound like the selected word in the search.



Thesaurus Edit Menu

Purpose
Use the options on the Edit menu to change the lookup text.

Steps

1 Open Thesaurus, then choose Edit.

2 Choose from the following options:
Undo
Cut
Copy
Paste
Select All

3 Choose Look Up.

See Also
Thesaurus Change Dictionary
Thesaurus History Menu



Thesaurus History Menu

Purpose
Use the History Menu to see a list of words you have looked up with Thesaurus.

See Also
Thesaurus Edit Menu
Thesaurus Look Up



Thesaurus Look Up

Thesaurus, Look Up

Purpose
Use Look Up to find synonyms or antonyms for a word you have entered.

If you choose a word from the History Menu, that word appears in the Word text box and 
becomes the new headword. A headword appears at the top of a column in the Thesaurus 
word lists.

Steps

1 From Thesaurus, type a word, then choose Look Up.
or
Paste in a word, then choose Look Up.Double-click a word marked with a bullet in the 
Thesaurus word lists.

2 Use the arrow buttons to move left and right through the Thesaurus word lists. You can 
create as many word lists as memory allows.

See Also
Thesaurus Edit Menu
Thesaurus Replace



Paste
Places text from the Clipboard into the Word text box.



Thesaurus Replace

Thesaurus, Replace

Purpose
Use Replace to substitute a selected word in your document with a word from the 
Thesaurus.

Steps

1 Select a word in the document.

2 Open the Thesaurus.

3 Select the word you want.

4 Choose Replace.

See Also
Thesaurus Look Up



Select All
Selects all the text in the Word text box. You can then cut or copy it to the Clipboard, or 
replace it with another term.



Recheck All Text
Spell Checker "remembers" what parts of a document it has spell-checked during a session. 
The next time you spell-check, it only checks text it has not checked before. Select Recheck 
All Text when you want to spell-check an entire document or text area, both new text and 
text you have previously spell-checked.



Undo
Reverses the effect of the most recent change you made to the text in the Word text box.



Spell Checker Check Menu

Spell Checker, Check

Purpose
Use the options on the Check menu to select the part of a document or text entry box you 
want to spell-check.

Steps

1 Open Spell Checker in the document or text entry box that you want to spell-check, 
then choose Check.

2 Choose from the following options:
Word
Sentence
Paragraph
Page
Document
To End of Document
Selected Text
Text Entry Box
Number of Pages

3 Choose Start to begin the spell-check.

See Also
Spell Checker
Spell-Checking
Spell Checker Dictionaries Menu
Spell Checker Number of Pages
Spell Checker Options Menu



Spell Checker Options Menu

Spell Checker, Options

Purpose
Use the options on the Options menu to select the types of checking you want to use for 
the current spell-check. The options you select remain in effect until you change them.

Steps

1 Open Spell Checker in the document or text entry box you want to spell-check, then 
choose Options.

2 Choose from the following options:
Words with Numbers
Duplicate Words
Irregular Capitalization
Exhaustive Checking
Auto Replace
Auto Start
Recheck All Text
Document Dictionary
QuickCorrect Dictionary
Beep on Misspelled

3 Choose Start to begin the spell-check.

See Also
Spell Checker
Spell-Checking
Spell Checker Check Menu
Spell Checker Dictionaries Menu



Scan Off
Appears as /Noscan

Disables QuickFinder's scanning in proximity and quoted searches. This results in a longer 
list of files that include the search words, but does not check their order or closeness.



 folder icon
A small file folder icon next to a text box. The folder icon appears on dialog boxes and is 
used to access another dialog box to select files or change directories. Sometimes called a 
list button.



menu
A list of options displayed on screen from which you can select a particular function or 
command.



QuickCorrect Dictionary
Enables the QuickCorrect Dictionary (.qcs) so the Spell Checker can use the QuickCorrect list
during a spell check.    Use this option instead of chaining the QuickCorrect dictionary with 
the other available dictionaries.



directory dialog box
Dialog boxes that allow you to open, save, name, find, view, copy, move, rename, delete, 
and print files. They also let you create and remove directories. Directory dialog boxes 
appear when you use any feature that retrieves or saves a file, such as Open, Save As, Insert
File, and so on.



Relevancy in QuickFinder Searches

QuickFinder, Options, Estimated Relevance Ranking and Full Word Count Relevance

Purpose
Use Estimated Relevance Ranking and Full Word Count Relevance to let QuickFinder rank 
the documents satisfying the search query in order of relevancy, based on the number of 
words found. Complex queries with several words will give higher Relevancy numbers, 
since relevancy is additive. Relevancy numbers apply only to the current search query-
they are not comparable across different queries.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, define a search query 
using a file pattern or word pattern, along with any operators, date ranges, and 
document summary field information you want to search for.

2 Choose Options, then choose Estimated Relevance Ranking.
or
Choose Full Word Count Relevancy.

3 Choose Find.

The Search Results List appears sorted in order of relevancy, with the most relevant at 
the top of the list. This is how QuickFinder determines relevancy:

Scan and Index searching with Full Word Count Relevance:    QuickFinder automatically 
uses a scanning search.    The Search Results List displays the number of times the 
search text is found in the document. This search takes longer but is more precise.

Index searching with Estimated Relevance Ranking:    The Search Results List displays 
the number of hits (search elements) found, determined by the level of the index 
(document paragraph, line, and so on).

Scan searching with Estimated Relevance Ranking:    The Search Results List displays 
the estimated # of hits per 1000 words. If the search word(s) is found on page 1, 
QuickFinder estimates how many hits the document would yield in each 1000 words.

See Also
QuickFinder
QuickFinder Search Results List



dialog box
Dialog boxes let you communicate with an application. They display warnings and messages,
and they let you select and implement options by choosing appropriate command buttons. 
Dialog boxes have a title bar and a control menu, but they do not have a menu bar. They can
be moved to different locations on the screen. Most dialog boxes must be closed before you 
can work in the document window, but a few allow you to move between the window and 
the dialog box.

When a dialog box option is unavailable and cannot be used, it appears dim. If subsequent 
actions make the item available, it changes to a normal appearance.



text box (dialog box)
The area in a dialog box where you type text or where the application types text for you. The
selection insertion point must be in the text box before you can begin to type.



Viewer Info
Lets you display default settings by viewer or file type.



Find Next
Lets you find the next occurrence of the current Viewer search text. (Find Next appears only 
if you have used Find in a text file.)



Find Previous
Lets you find the previous occurrence of the current Viewer search text. (Find Previous 
appears only if you have used Find in a text file.)



Spell Checker Document Dictionary

Spell Checker, Options, Document Dictionary

Purpose
Use the Spell Checker Document Dictionary option to enable or disable the document 
dictionary. The document dictionary is a supplementary dictionary that is automatically 
attached to each document you create. When you enable the Document Dictionary option,
you can add words to the document dictionary during a spell-check session.

Steps

1 Open Spell Checker in the document that you want to spell-check.

2 Choose Options, then select Document Dictionary.

3 Choose Add To, then select Document Dictionary.

4 Choose Start to begin running the spell-check, then choose Add when Spell Checker 
stops on a word that you want to add to the document dictionary.

See Also
Spell-Checking
Spell Checker Dictionaries Menu
Spell Checker Options Menu
Spell Checker Supplementary Dictionaries



drop-down list
A list of options that appears to "drop down" from an option when you click a button in a 
dialog box. Drop-down lists are marked by downward-pointing arrows.



pop-up list
A list of options that appears when a pop-up button is selected. Most pop-up lists are marked
by double arrows or triangles and display mutually exclusive options. The button itself shows
the selected option. Other pop-up lists, marked by single arrows or triangles, show the 
feature name rather than the selected option.



Spell Checker Dictionaries Menu

Spell Checker, Dictionaries

Purpose
Use the options on the Dictionaries menu to choose the main dictionaries and 
supplementary dictionaries you want to use. When you spell-check a document, Spell 
Checker first checks the word in selected supplementary dictionaries that you create and 
customize, then in the word lists or rules in the main dictionaries you select.

Steps

1 Open Spell Checker in the document or text entry box that you want to spell-check.

2 Choose Dictionaries, then choose Main or Supplementary.

Choose from the following options for more information:
Main
Supplementary

See Also
Spell Checker Add Word/Phrase
Spell Checker Check Menu
Spell Checker Document Dictionary
Spell Checker Edit Dictionary
Spell Checker Options Menu



Replace
Replaces the word or phrase with the text specified in the Replace With text box. You can 
select one of the items in the Suggestions list box or edit the word in the text box.



headword
A word that can be looked up in the Thesaurus. A reference marked with a bullet is a 
headword. Select a headword to display other references which are divided into nouns (n), 
verbs (v), adjectives (a), and antonyms (ant).



Skip Once
Skips one occurrence of the selected word or phrase during the current spell-check.

You can specify a word as uppercase, lowercase, or both by typing the word with the case 
you want in a supplementary dictionary. If the word you define is used in your document 
with a different case than the one specified, Spell Checker selects the word as a 
capitalization difference.



Skip Always
Skips every occurrence of the selected word or phrase during the current spell-check.

You can specify a word as uppercase, lowercase, or both by typing the word with the case 
you want in a supplementary dictionary. If the word you define is used in your document 
with a different case than the one specified, Spell Checker selects the word as a 
capitalization difference.



About QuickFinder

QuickFinder, Indexer, Options, About

Purpose
The WordPerfect QuickFinder File Indexer is an application you can use to create indexes 
for selected documents and then rapidly search through these indexes for documents 
containing a specific word or phrase. You can also use QuickFinder to search for specific 
files and file patterns.

Use About QuickFinder to read about your version of QuickFinder, the release date, 
program paths, and initialization files.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, choose Indexer, then 
choose Options.

2 Choose About.

3 Choose OK.

See Also
QuickFinder
QuickFinder Indexer
QuickFinder Indexer Options



About Thesaurus

Thesaurus, Help, About Thesaurus

Purpose
The WordPerfect Thesaurus is an application you can use to search for synonyms or 
antonyms of words.

Use About Thesaurus for information about your version of the WordPerfect Thesaurus, the
release date, program paths, and initialization files.

Steps

1 From Thesaurus, choose About Thesaurus from the Help menu.

2 Choose OK.

See Also
Thesaurus



Add
Adds the word or phrase to the selected dictionary.

Before you choose Start to begin a spell-check, you can select the dictionary you want to 
add words to.



Add or Edit QuickList Item

QuickList, Add Item

Purpose
Use Add QuickList Item to add items to the list of directories and files you use frequently. 
Use Edit QuickList Item to edit your list of frequently used directories and files.

Steps
To add a QuickList item,
1 Enter any directory dialog box.

2 Right-click on the QuickList, then choose Add Item.

3 Specify the directory or filename you want to add to the QuickList.

4 Type a descriptive name.

5 Choose OK.

To edit a QuickList item,
1 Enter any directory dialog box.

2 Select the item you want to edit.

3 Right-click on the QuickList, then choose Edit Item.

4 Make the changes you want.

5 Choose OK.

See Also
Delete QuickList Item
QuickList



Suggest
Displays additional words or phrases, if there are any, in the Suggestions list box.



Change File Attributes

Purpose
Use Change Attributes to change the Archive, Read-Only, Hidden, and System attributes of
one or more files. 

Steps

1 In a directory dialog box, select the file(s) you want to change. Make sure the selected 
files are not already open.

2 Right-click on the files list, then choose Change Attributes.

3 Choose from the following options:
Archive
Read-Only
Hidden
System

4 Choose OK.

See Also
File Options



Insert Macro Commands

Purpose
Use the Command Listing to easily insert product commands into an application you are 
building.

Steps

1 Open your programming application.

2 Choose the command you want to insert.

3 Select a parameter.

4 Type in or select the value for the parameter, then choose Update.

5 Edit a parameter by selecting the parameter and changing its value.

6 Choose OK to insert the completed product command.

See Also
Editing Macros
Macro Facility



 Hint
To open a file without choosing OK, double-click a filename in the file list box of a directory 
dialog box that lets you open files.



 Hint
Insert new filenames into the Dictionaries in Search Order list one item at a time. New 
filenames are inserted on the line above the line selected in the list box.

To add a dictionary to the end of your chain, select the first blank line after the last filename.

Delete and reinsert the filenames to change the search order that Spell Checker follows 
through your dictionary chain.



 Hint
When you delete a dictionary filename from a dictionary chain, you are not deleting the 
dictionary file itself.



Remove Highlights
Removes any highlights placed in the Viewer file by Find.



 Hint
You can select Auto Replace from the Options menu to have Spell Checker automatically 
make the replacements you define.



Language

Purpose
Use Language to specify the language conventions for text in your documents and to 
specify a language to use with Grammatik, Hyphenation, Document Information, Spell 
Checker, and Thesaurus. WordPerfect applications also use language codes to customize 
date and time formatting, sorting orders, and currency symbols.

You can change the language for the current document only, in the initial codes style (for 
features such as Grammatik and Sort), and in the default initial codes style to use the 
formatting conventions of another language in all new documents.

            Each copy of a WordPerfect application normally comes with only one 
dictionary for the Spell Checker, Thesaurus, and Hyphenation features.    At least one 
additional language module must be installed in order to use a different language. You 
can purchase language modules separately. Language modules also include keyboard 
files.

Steps

1 Place the insertion point where you want to specify the formatting conventions for 
another language.
or
Select the text you want to specify conventions for.

2 Open the Language dialog box.

3 Choose a language.
or
Type a two-letter language code in the Language text box.

4 Select Disable Writing Tools (in this portion of the text) if you want Spell Checker, 
Grammatik, or Thesaurus to skip the selected text.

5 Choose OK.



Drag and Drop Capabilities

Purpose
Use the drag-and-drop capabilities built into directory dialog boxes to launch applications, 
open files, package files as OLE objects, and create Windows Program Manager icons for 
applications.

Steps
To launch an application,
1 In a directory dialog box, drag a filename from the list box onto the .EXE file for the 

application you want to launch.

This launches the application and opens the selected file within it.

To open a file in an open application,
1 Open the application you want to work in.

2 Open a directory dialog box in another application.

3 Drag the filename of the file you want from the files list onto the title bar of the 
application.

To package a file as an OLE object,
1 Open a directory dialog box.

2 Drag the filename of the file you want from the files list into an open document window 
in a different application.

To create an application icon,
1 Open a directory dialog box.

2 Drag an .EXE file into a Program Group in Windows Program Manager.

See Also
Managing Files
Opening Files



 Hint
Filenames can be a maximum of eight characters, followed by a period and a three-
character extension. When you name a document, do not use the following characters:    * + 
= [ ] : ;      < > ? / \ |. A period can be used only to separate the first part of the filename from
the filename extension. For example, if you specify the filename GIRAFFE.ABCD, WordPerfect
applications will read and record the name as GIRAFFE.ABC. 

If you do not specify an extension, WordPerfect applications save the file with the extension 
that identifies the format selected. Specify a filename that ends with the period if you do not
want to add the default extension.



Import Indexes

QuickFinder, Indexer, Options, Import

Purpose
Use Import to access QuickFinder indexes created by others.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, then choose Indexer.

2 Choose Options, then choose Import. You can select more than one index at a time to 
import.

See Also
QuickFinder
QuickFinder Indexer
QuickFinder Indexer Options



 Hint
You will not be able to recover the files or subdirectories after you delete them.

If you do not select a different directory before choosing Remove Directory, the application 
will remove the current directory.



 Hint
You can directly access the Add Word/Phrase dialog box to add items to the currently 
selected supplementary dictionary by choosing Add in the Spell Checker dialog box before 
you start a spell-check.



Rename Directories

Purpose
Use Rename Directory to give directories new names.

Steps

1 In a directory dialog box, right-click on the Directories list, then choose Rename 
Directory.

2 Specify the new location or name for the selected directory, then choose Rename.

See Also
Create Directory
Remove Directory



Archive
Archives or backs up the file(s) the next time you run a third-party backup program.



Copy Files

Purpose
Use Copy to copy one file or multiple files into other drives or directories.

Steps

1 In a directory dialog box, select the file(s) you want to copy. 

2 Right-click on the files list, then choose Copy.

3 Specify the path or filename for the file(s).

4 Select Don't replace files with the same size, date, and time to avoid copying files that 
are identical to the files they would replace.

5 Choose Copy.

You can also copy files by selecting a filename from the list box and dragging it to 
another drive or directory in the Directories list box or the QuickList.

See Also
Move Files
Rename Files



Create Directory

Purpose
Use Create Directory to create a new directory or subdirectory in the current drive.

Steps

1 In a directory dialog box, select the drive or directory you want to add a directory to.

2 Right-click on the Directory list, then choose Create Directory.

3 Type a name for the directory.

4 Choose Create.

See Also
File Options
Remove Directory
Rename Directory



Index Name

QuickFinder, Indexer, Create

Purpose
Use Index Name to specify a name for the QuickFinder index you are about to create.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, then choose Indexer.

2 Choose Create.

3 Type a name for the index, then choose OK.

See Also
Create Index
QuickFinder



Read-Only
Protects the file(s) from being modified or deleted.



Password Protect

Purpose
Use Password Protect to assign a password to a WordPerfect document when you save it 
as a file and to remove a password from a file. When you protect a document with a 
password, any associated backup or temporary files that WordPerfect applications create 
are also protected.

            Enhanced Password Protection is case sensitive and includes powerful 
encryption capabilities. The Password feature is not available with all applications and 
file formats. If you save a password protected file in a non-WP format or WP 4.2 format, 
the password is removed.

Steps
To assign a password to a file,
1 In a directory dialog box, type the name of the file you want to save.
or
Select the name of the file you want to replace with the file you are saving.

2 Choose a WordPerfect format that supports the Password Protect feature.

3 Select Password Protect, then choose OK.

4 If you chose WordPerfect 6.0 format, select Enhanced or Original password protection, 
then choose OK.

5 Type the password that you want to use, then choose OK.

6 Re-type the password, then choose OK.

To open a password-protected file,
1 In a directory dialog box, type the name of the protected file you want to open, then 

choose OK.

2 Type the assigned password, then choose OK.

To remove a password from a file,
1 In a directory dialog box, specify the name of the protected file, then choose OK.

2 Type the password, then choose OK.

3 In the open password-protected file, choose Save As from the File menu.

4 Specify the name of the protected file, deselect Password Protect, then choose OK.

5 Choose Yes to replace the password-protected file.



Resume
Lets you re-start an incomplete spell-check. The Resume button appears in place of the 
Replace button on the Spell Checker dialog box when you interrupt a session of Spell 
Checker to edit text in a document window or text entry box before a spell-check is 
completed.



Custom Columns
If you also select Show Column Labels, Custom Columns lets you select from a list of column 
types to display in a file list.



Location for Index Files

QuickFinder, Indexer, Options, Preferences

Purpose
Use Location for Index Files to identify the directory where you want to place your 
QuickFinder indexes.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, then choose Indexer.

2 Choose Options, then choose Preferences.

3 Specify a location for Index Files, then choose OK.

See Also
QuickFinder
QuickFinder Indexer Options



Delete Files

Purpose
Use Delete to delete one or more files.

Steps

1 In a directory dialog box, select the file(s) you want to delete. 

2 Right-click on the files list, then choose Delete.

3 Choose Delete.

See Also
Copy Files
File Options
Move Files



Hidden
Hides the file(s) in directory dialog box file lists and QuickFinder Search Results lists, and 
makes it a hidden file for DOS.



 Hint
To select a column label, click a blank space between column labels with the right mouse 
button, then choose an option. You may need to scroll right to find a blank space.



Wildcard Off and Wildcard On
Appear as /Nowildcard and /Wildcard

Wildcard Off disables wildcard functionality and accepts * and ? as characters in your search 
query.

Wildcard On returns QuickFinder's wildcard capability and treats * and ? as wildcards, not as 
characters.



Network

Purpose
Use the Network options list to view and edit network settings. The number and type of 
options will vary depending on your network software. Network only appears if your 
computer is connected to a network.

Steps

1 Enter any directory dialog box, then choose Network.

Depending on the network driver and version you are using, the options that appear will
vary. Choose the Help buttons on the Network dialog boxes for more information.



Add Directory or File

QuickFinder, Indexer, Create or Edit, Add Directory or File

Purpose
Use Add Directory or File to create or edit a directory pattern that you want to include in 
the index.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, choose Indexer, then 
choose Edit.
or
Choose Create, specify an index name, then choose OK.

2 Type the pathnames of the drives and directories you want to index.
or
Choose Browse to select the drives and directories to be indexed.

3 Select Include Subtrees to include subdirectories.

4 Choose Add to add the directory pattern to the list of directories to be indexed.

5 Choose Generate to generate the index.

See Also
Create or Edit Index Criteria
QuickFinder
QuickFinder Indexer



Index File Information

QuickFinder, Indexer, Options, Information

Purpose
Use Index File Information to display information about the contents of your QuickFinder 
index files.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, choose Indexer.

2 Choose Options, then choose Information.

You must have an index created to use this option.

See Also
QuickFinder
QuickFinder Indexer
QuickFinder Indexer Options



Index Method

QuickFinder, Indexer, Generate

Purpose
Use Index Method to regenerate the entire index or just update the index with new, 
modified, or deleted files. Updating an index is faster than regenerating the entire index. 
But as the incremental (.INC) index file gets large, regenerate the entire index to speed up
the updating process.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, choose Indexer, then 
choose an index to update.

2 Choose Generate.

3 Choose Index All Files to regenerate the entire index.
or
Choose Update Index With New or Modified Files to update the index with new, 
modified, or deleted files.

4 Choose OK.

See Also
QuickFinder
QuickFinder Indexer



Individual Index Options

QuickFinder, Indexer, Create or Edit, Options

Purpose
Use Individual Index Options to specify indexing conditions for the selected QuickFinder 
Index.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, choose Indexer, specify an
index, then choose Edit.

2 Choose Options.

3 Choose from the following options:
Entire Document
Entire Document-Summary Fields
Text Only
Summary Fields Only
Filename Only

4 Select WordPerfect Documents Only to exclude unknown formats.

5 Select Include Numbers in Index to index numbers.

6 Specify file extensions you want to exclude from the index.

7 Specify an Index Level to determine how large an area to look for word patterns.

8 Specify how the index should interpret extended characters in unrecognized formats.

9 Choose OK.

See Also
Create or Edit Index Criteria
QuickFinder
QuickFinder Indexer



QuickFinder Search Query

QuickFinder, Options, Load Search Query, Save Search Query, Delete Search Query

Purpose
Use QuickFinder Options to save, reuse, or delete a QuickFinder search query.

Steps
To save a search query,
1 Open QuickFinder stand-alone or from a directory dialog box, define a search query 

using a file pattern or word pattern, along with any operators, date ranges, and 
document summary field information you want to search for.

2 Choose Options, then choose Save Search Query.

3 Type a name for the search, then choose Save.

To reuse a saved search query,
1 Choose Options, then choose Load Search Query.

2 Select the search query you want to retrieve, then choose Load.

To delete a search query,
1 Choose Delete Search Query.

2 Select the search query you want to delete, then choose Remove.

If you accidentally delete a name from the Search Query list, choose Cancel to exit the 
dialog box without saving the changes.

See Also
QuickFinder Options



 Hint
When the Document Dictionary is enabled, it is listed as the first supplementary dictionary 
on the Add To pop-up list in the Spell Checker dialog box. If the Document Dictionary is not 
enabled, the first dictionary in the supplementary dictionary chain is the dictionary selected 
by default on the Add To pop-up list. This is the wpspelus.sup file for stand-alone users and 
the wpxxxxxx.sup (where x's represent the user name and language code) for network 
users. The default dictionary file (both are shipped with Spell Checker) remains the first 
dictionary in the chain until you create additional dictionary files and add them to the 
supplementary dictionary chain.



Prefix Mode On and Off
Appear as /Prefix and /Noprefix

Prefix Mode On treats all search terms as wildcard searches.    For example, (/Prefix cat & 
dog) finds "cats," "catapult," "catalepsy," "dogs," "doggerel," and so on.

Prefix Mode Off turns off this functionality and searches only for the words specified.



Macro Facility Settings

Macro Facility, Settings

Purpose
Use the options on the Settings menu to examine and edit the current settings in the 
Macro Facility.

Steps

1 Choose Options from the Settings menu in the Macro Facility, choose the options you 
want, then choose OK.

2 Choose Reset to defaults from the Settings menu to change the Macro Facility options to
the default settings.

3 Choose Save settings from the Settings menu to save the current Macro Facility option 
settings.

4 Choose Save settings on Exit from the Settings menu to save the settings when you exit
the Macro Facility.

Choose the following option for more information:
Options

See Also
Macro Facility Macros Menu
Recording Macros
Using Macros



View Public Information in BIF Files

BIF Edit, View, View Public Information

Purpose
Use View Public Information to display the parts of an opened .BIF file that come from a 
public BIF instead of a private BIF. Public BIF files provide network-wide initial settings to 
provide a uniform startup environment for network users. Private BIF files provide initial 
settings for only one user. Private BIF settings have precedence over Public BIF settings, 
unless a system administrator flags settings in the public BIF to override settings in 
private BIFs.

Steps

1 Double-click the BIF Edit icon from the Windows Program Manager.

2 Choose Open Private BIF.
or
Choose Open, specify the BIF you want to edit, then choose Open.

3 Choose View Public Information from the View menu.

See Also
BIF Edit Override



Sentence
Checks the sentence in which the insertion point is located in a document.



BIF Edit

Purpose
Use BIF Edit if you are a network supervisor to set and edit public and private .BIF files. 
Public BIF files provide network-wide initial settings to provide a uniform startup 
environment for network users. Private BIF files provide initial settings for only one user. 
Private BIF settings have precedence over Public BIF settings.

            BIF Edit is intended for use by network supervisors and administrators and it is
suggested that the Editor is not made available for general use by end users. Only use 
the BIF Editor for making adjustments to the program that cannot be made during 
installation or in the program itself, such as flagging settings in the public BIF to 
override settings in private BIFs and setting relative drive paths for file locations. The 
README.NET file contains suggestions on customizing BIF settings.

You must have the BIFED20=US entry under the [WordPerfect] section of your WIN.INI 
file to run the BIF Editor.

Steps

1 Double-click the BIF Edit icon from the Windows Program Manager.

2 Choose Open Private BIF.
or
Choose Open, specify the BIF you want to edit, then choose Open.

3 Select the feature or application you want to edit.

4 Make the desired changes in the .BIF file. 

5 Choose Exit from the File menu, then choose Yes.

Choose from the following options for more information:
Edit
Insert
Delete
Override

See Also
About BIF Edit
BIF Edit Startup Switches



System
Identifies the file(s) to DOS as part of your computer's operating system. The file(s) are not 
displayed in directory dialog box file lists or QuickFinder Search Results lists.



Move Files

Purpose
Use Move to move one or more files to a different drive or directory.

Steps

1 In a directory dialog box, select the file(s) you want to move.

2 Right-click on the files list, then choose Move.

3 Type the path or filename you want the file(s) moved to.
or
Click the list button, select the directory you want the files moved to, then choose OK.

4 Choose Move.

You can also move files by selecting a filename from the list box and pressing Alt or Shift
while dragging it to another drive or directory in the Directories list box or the QuickList.

See Also
Copy Files
File Options



Move Index File

QuickFinder, Indexer, Options, Move

Purpose
Use Move Index File to move a QuickFinder index file to a different file location.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, then choose Indexer.

2 Select the index you want to move.

3 Choose Options, then choose Move.

4 Type a new filename and network or local directory, then choose OK.

See Also
Network Index File Location
QuickFinder Indexer
QuickFinder Indexer Options



Network Index File Location

QuickFinder, Indexer, Options, Move

Purpose
Use Move Index File to move a QuickFinder index file to a network file location.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, choose Indexer, then 
choose Options.

2 Select the index you want to move.

3 Choose Move.

4 Type a new network or local directory and filename, then choose OK.

See Also
Location for Index Files
Move Index File



Managing Files

Purpose
In WordPerfect applications, file management capabilities are provided in directory dialog 
boxes. For example, you can use this dialog box to select directories, choose macros, 
locate specific files, open documents, and save documents as new or renamed files. You 
can find and select directories and files using the drive, directory, and file lists. You can 
also change network connection or document management options if you are connected 
to a network or have alternate document management programs.

To find a more specific Help topic about your task, use the Search button above to look up 
the title of a specific dialog box or option.

            The options that appear on this dialog box will change depending on its title 
and the application in which it appears.

Choose from the following options for more information:
Filename
File List
Save File As Type
Directories List
QuickList
Drives
List Files of Type

See Also
Drag and Drop Capabilities
File Options
Network
ODMA Support
Opening Files
Saving Files



Open/Save As Setup

Purpose
Use Open/Save As Setup to specify how you want to display the file list and to set the 
Speedup Files options for directory dialog boxes.

Steps

1 Enter any directory dialog box, then choose Setup.

2 Make the changes you want, then choose OK.

Choose from the following options for more information:
Create Speedup Files
File List Display
Sorting Files

See Also
Managing Files



Auto Start
Automatically starts spell-checking when you activate the Spell Checker. If you have already 
selected text, spell-checking will begin automatically even if you have not selected Auto 
Start.



Using Macros

Macro Facility, Play File macro, Pause play, Resume play, Stop play

Purpose
Use macros to carry out procedures inside WordPerfect applications. You can play, pause, 
resume, and stop macros using options on the Macros menu. When you play a macro, the 
Macro Facility repeats the commands it contains inside the WordPerfect application.

Steps
To play a macro,
1 From the Macro Facility, choose Play File macro from the Macros menu.

2 Select the macro you want to play, then choose Play.

To pause a macro,
1 Choose Pause play from the Macros menu.

2 Select the macro you want to pause, then choose Pause.
or
Select Apply to all macros to pause all macros, then choose Pause.

To continue playing a paused macro,
1 Choose Resume play from the Macros menu after you have paused a macro.

2 Select the macro you want to resume, then choose Resume.
or
Select Apply to all macros to resume all macros, then choose Resume.

To stop a macro,
1 Choose Stop Play from the Macros menu.

2 Select the macro you want to stop, then choose Stop.
or
Select Apply to all macros to stop all macros, then choose Stop.

See Also
Managing Files
Macro Facility Settings
Recording Macros



Macro Facility

Purpose
Use the Macro Facility to record, play, compile, convert, or edit one or more macros.

Steps

1 Double-click the Macro Facility icon from the Windows Program Manager.
or
Choose Run from the File menu in the Windows Program Manager, type c:\<path>\
mfwin20.exe, then choose OK.

Choose from the following options for more information:
Options
Macros
Settings

See Also
Additional Information about Macro Facility
Recording Macros
Using Macros



Print Files

Purpose
Use Print to print one or more files without opening them into the current document 
window.

Steps

1 In a directory dialog box, select the file(s) you want to print. 

2 Right-click on the files list, then choose Print.

3 Choose Print.

See Also
File Options
Print Lists



Print Lists

Purpose
Use Print List to print a list of selected files or all files displayed in the file list box, the 
Directory List, or the QuickList.

Steps
To print a file list,
1 In a directory dialog box, choose Setup, then select the File List Display options you 

want. The information displayed on a printed file list is identical to the information 
displayed in the file list box.

2 Select the files in the file list that you want to include on the printed list. Skip this step if
you want to print the entire file list.

3 Right-click on the files list, then select Print File List.

4 Choose the type of list you want to print.

5 Select Include Subdirectories to print subdirectories in addition to the list.

6 Choose Setup, select a printer, orientation, and paper size and source, then choose OK.

7 Choose Change, select a font, style, and size, then choose OK.

8 Choose Print.

To print a directory list,
1 Enter any directory dialog box, then right-click on the Directories List.

2 Choose Print Directory List.

3 Select the printing option you want.

4 Choose Setup, select a printer, orientation, and paper size and source, then choose OK.

5 Choose Change, select a font, style, and size, then choose OK.

6 Choose Print.

To print a QuickList,
1 Enter any directory dialog box, then choose QuickList.

2 Choose Print QuickList.

3 Select the printing option you want.

4 Choose Setup, select a printer, orientation, and paper size and source, then choose OK.

5 Choose Change, select a font, style, and size, then choose OK.

6 Choose Print.



See Also
File Options
Print Files



Converting Macros

Purpose
Use Convert Macro to convert a WordPerfect macro to WordPerfect 6.1 for Windows 
format.

Steps

1 From the Macro Facility, choose Play File macro from the Macros menu.

2 Specify the filename of the macro you want to convert.

3 Choose Play.

4 Specify a new filename for the macro, then choose Convert.

See Also
Compiling Macros
Macro Facility



QuickFinder Indexer

QuickFinder, Indexer

Purpose
Use the QuickFinder File Indexer to create or edit indexes. QuickFinder indexes are full-
text, alphabetical lists of every word contained in the files and directories you specify as 
well as information about the files. You cannot view or print QuickFinder indexes; they are 
highly compressed for QuickFinder use only. Searching a QuickFinder index for a word or 
phrase is extremely fast, compared to opening and searching each individual file.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, then choose Indexer.

2 Choose Create, type an index name, then choose OK.
or
Select the name of the index you want to edit, then choose Edit.

3 Type the name of the directory or file you want to add, then choose Add.
or
Choose Browse for a list of files and directories.Select the directories you do not want to
include in an existing index, then choose Remove.

4 Select Include Subtree to include all subdirectories under the directories you have 
added to the list.

5 Choose Options to specify individual index options.

6 Choose Generate to generate the index of the selected files.
or
Choose an Index Method option to update a previously created index.

See Also
Additional Information about QuickFinder
Create or Edit Index Criteria
Index Method
Individual Index Options
QuickFinder
QuickFinder Indexer Options



QuickFinder Indexer Preferences

QuickFinder, Indexer, Options, Preferences

Purpose
Use Preferences to change how QuickFinder creates an index. Most of the options affect 
the speed of indexing.

Steps
To change options for all indexes,
1 Open QuickFinder stand-alone or from a directory dialog box, then choose Indexer.

2 Choose Options, then choose Preferences.

3 Specify how often you want to display indexing progress.

4 Specify a Location for Index Files.

5 Select Expand Browse Dialog to display the Filename and Directories list boxes by 
default.

6 Choose Advanced>> to set further Indexer defaults.

7 Specify which file extensions you want to exclude.

8 Select WordPerfect Documents Only to limit indexing to documents in WordPerfect 
format.

9 Choose index contents and indexing levels.

10 Select Include Numbers in Index to index numbers as well as words.

11 Choose an option for Extended Characters.

12 Choose OK.

To change options for a particular index,
1 Select the index.

2 Choose Edit, then choose Options.

See Also
Additional Information about QuickFinder
Individual Index Options
QuickFinder
QuickFinder Indexer
QuickFinder Indexer Options



Recording Macros

Macro Facility, Record Macro, Pause record, Stop record

Purpose
Use Record, Pause record, and Stop record while creating keyboard macros. When you 
record, the Macro Facility keeps track of the actions you perform in a WordPerfect 
application, such as typing text or saving a file.

Steps
To record a macro,
1 From the Macro Facility, choose Record from the Macros menu.

2 Type a name for the macro.
or
Press Ctrl+x or Ctrl+Shift+x (where x represents a character a-z or 0-9) to assign your 
macro to a keystroke combination.

3 Choose Record.

4 Switch to a WordPerfect application or another macro-enabled program, then use it to 
record keyboard actions in the macro.

To pause while recording a macro,
1 Choose Pause record from the Macros menu while recording a macro if you want to 

locate a feature or experiment with the effect of a feature before you record the 
command.

2 Choose Pause record again when you are ready to continue recording the macro.

To stop recording a macro,
1 Choose Stop record from the Macros menu to turn off the macro you are recording.

See Also
Using Macros



Remove Directory

Purpose
Use Remove Directory to remove a directory and to delete any subdirectories and files 
contained in the directory you want to remove. If you do not select a different directory, 
the application will delete the current directory.

Steps

1 In a directory dialog box, select the directory you want to remove.

2 Right-click on the Directories list, then choose Remove Directory.

3 Choose Yes to delete the selected directory, including all files and subdirectories in it.

See Also
Create Directory
Delete Files
File Options
Rename Directory



About Macro Facility

Macro Facility, About Macro Facility

Purpose
The WordPerfect Macro Facility is an application that you can use to record, play, compile, 
convert, and edit WordPerfect macros.

Use macros to record commands that perform tasks automatically. For example, you can 
create a macro that retrieves a file, gives it a new name, and saves it in another format.

Use About Macro Facility for information about your version of the WordPerfect Macro 
Facility, the release date, program paths, and initialization files.

Steps

1 In Macro Facility, choose About Macro Facility from the Help menu.

2 Choose OK.

See Also
Macro Facility



Rename Files

Purpose
Use Rename to give one or more files new names and locations.

Steps

1 In a directory dialog box, select the file(s) you want to rename.

2 Right-click on the files list, then choose Rename.

3 Specify the new path or filename for the selected file(s), then choose OK.

4 Choose Rename.

See Also
File Options
Move Files
Select Directory



Rename Index

QuickFinder, Indexer, Options, Rename

Purpose
Use Rename Index to give a QuickFinder index a different name.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, choose Indexer, then 
select an index name.

2 Choose Options, then choose Rename.

3 Type a new name, then choose OK.

See Also
Index Name
QuickFinder
QuickFinder Indexer
QuickFinder Indexer Options



Macro Facility Macros Menu

Macro Facility, Macros

Purpose
Use the options on the Macros menu to play, record, compile, and edit macros.

Play File macro
Pause play
Resume play
Stop play
Record
Pause record
Stop record
Compile
Stop Compile
Edit

See Also
Macro Facility
Macro Facility Settings



Entire Document
Indexes both text and document summary fields, including subfunctions:    headers, footers, 
footnotes, tables, graphics, and so on. However, document summary information is 
combined with text information in the index.



QuickFinder Search Results List

QuickFinder, Find, Search Results

QuickFinder, Options, Last Search Results

Purpose
A Search Results List, generated by a QuickFinder search, contains the files that match the
search criteria you entered. From the Search Results List you can open as many as nine 
files. You can also copy, move, rename, delete, preview, or print files, or save the list for 
reference in further searching.

Steps
To generate and use a list of search results,
1 Open QuickFinder stand-alone or from a directory dialog box, type a search query, then 

choose Find. 

If any files match the search criteria, a Search Results List will display. If not, you will 
see a No Files Found message.

2 Select the file(s) you want to process from the Search Results List, then choose either 
Open, View, or one of the File Options.
or
Choose QuickFinder to continue searching.

To save your Search Results List for future use,
1 Select Save Search Results from the Search Results List, then choose either Open or 

Close.

2 Choose QuickFinder again to retrieve the saved search results list, choose Options, then 
choose Last Search Results.

To further refine your search,
1 Choose QuickFinder from the Search Results List.

2 Note that Search In contains a new item called Search Results List. Choose this item if 
you want to use your previously created search results list.

3 Select Add Matching Files to Search Results List to include matching files to your list.

4 Choose Find. The Search Results List will be displayed again if you have any matching 
files.

Choose from the following options for more information:
View
QuickFinder
File Options
Sort Setup

See Also
Expand Word Searches



QuickFinder Indexer
QuickFinder Summary Fields
Refine QuickFinder Searches
Relevancy in QuickFinder Searches



QuickFinder Search Results Sort Setup

QuickFinder, Find, Search Results, Sort Setup

Purpose
Use Search Results Sort Setup to sort files in the QuickFinder Search Results by filename, 
extension, size, date/time, descriptive name, descriptive type, or path, in ascending or 
descending order.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, type a search query, then 
choose Find. 

2 Choose Sort Setup in the Search Results List.

3 Choose a Sort criterion.

4 Choose an Ascending or Descending sort order, then choose OK.

See Also
QuickFinder
QuickFinder Search Results List
Relevancy in QuickFinder Searches



About Spell Checker

Spell Checker, Help, About Spell Checker

Purpose
The WordPerfect Spell Checker is an application you can use to check documents, parts of 
documents, and text entry boxes for misspelled words, duplicate words, and irregular 
capitalization. You can run a separate copy of Spell Checker within each open document 
window. You select the dictionaries that are used during each spell-check.

Use About Spell Checker for information about your version of the WordPerfect Spell 
Checker, the release date, program paths, and initialization files.

Steps

1 From Spell Checker, choose About Spell Checker from the Help menu.

2 Choose OK.

See Also
Spell Checker



Spell Checker Add Word/Phrase

Spell Checker, Dictionaries, Supplementary, Edit, Add

Purpose
Use Add Word/Phrase to update selected supplementary dictionaries with key words and 
phrases that you want Spell Checker to ignore or replace. You can also define alternative 
word lists and comments for specified key words and phrases.

Steps

1 Open Spell Checker in the document or text entry box that you want to spell-check.

2 Choose Dictionaries, then choose Supplementary.

3 Select the supplementary dictionary you want, choose Edit, then choose Add.

4 Choose one of the following Add Word/Phrase options:
Skip
Replacement
Alternatives

5 Choose Apply to update the selected supplementary dictionary without exiting the 
dialog box.
or
Choose OK to update and exit.

See Also
Spell Checker Edit Dictionary
Spell Checker Supplementary Dictionaries



BIF Edit Delete

BIF Edit, Delete

Purpose
Use Delete to delete a group, section, or item from the public .BIF file. 

Steps

1 Double-click the BIF Edit icon from the Windows Program Manager.

2 Choose Open Private BIF.
or
Choose Open, specify the BIF you want to edit, then choose Open.

3 Select the group, section, or item you want to delete.

4 Choose Delete.

See Also
BIF Edit
BIF Edit Insert



Spell Checker

Purpose
Use Spell Checker to check documents and other text entries for misspelled words, 
duplicate words, and irregular capitalization. Select the dictionaries and other options you 
want to use before you start a spell-check.

Steps

1 Open Spell Checker in the document or text entry box you want to spell-check.

2 Select the options you want to use from the Check, Dictionaries, and Options menus.

3 Choose the supplementary dictionary you want to add words and phrases to.

4 Choose Start to begin the spell-check.

Choose from the following options for more information:
Add
QuickCorrect
Check
Dictionaries
Options
Help

See Also
Spell-Checking



Spell Checker Main Dictionaries

Spell Checker, Dictionaries, Main

Purpose
Use Main Dictionaries to select the main dictionaries that you want Spell Checker to 
search during a spell-check.

You can link as many as nine compatible main dictionaries to the main WordPerfect 
dictionary to create the chain of dictionaries you want to use. You can also add 
dictionaries to or delete dictionaries from the chain used for your last spell-check to create
a new chain for the next spell-check.

Steps

1 Open Spell Checker in the document or text entry box that you want to spell-check.

2 Choose Dictionaries, then choose Main.

3 Choose Language if you want to change the default language selection, select the 
language you want, then choose OK.

4 Choose Add, select a main dictionary file, then choose OK to add the dictionary to your 
main dictionary chain.
or
Select a dictionary, then choose Delete to remove the dictionary from your chain.

5 Choose Close.

See Also
Language
Spell Checker Dictionaries Menu
Spell Checker Supplementary Dictionaries



Spell Checker Edit Dictionary

Spell Checker, Dictionaries, Supplementary, Edit

Purpose
Use Edit Dictionary to edit the key words and phrases in a selected supplementary 
dictionary.

Steps

1 Open Spell Checker in the document or text entry box that you want to spell-check.

2 Choose Dictionaries, then choose Supplementary.

3 Select the supplementary dictionary you want to update, then choose Edit.

4 Choose Add, type the word or phrase you want to add, choose the options you want, 
then choose OK.

5 Select the key word or phrase that you want to delete or edit.

6 Choose Delete, then choose Yes.
or
Choose Edit, then choose one of the following Edit Word/Phrase Options: Skip
Replacement
Alternatives

7 Choose Close.

See Also
Spell Checker Add Word/Phrase
Spell Checker Supplementary Dictionaries



BIF Edit Edit

BIF Edit, Edit

Purpose
Use Edit to edit the value of an item.

Steps

1 Double-click the BIF Edit icon from the Windows Program Manager.

2 Choose Open Private BIF.
or
Choose Open, specify the BIF you want to edit, then choose Open.

3 Double-click the group, section, or item you want to edit.

The Type and Value for the highlighted item appears at the bottom of the dialog box.

4 Choose Edit.

5 Specify a value (a directory path, Boolean value, or number).

6 Choose OK.

See Also
BIF Edit Delete
BIF Edit Insert



Spell Checker Number of Pages

Spell Checker, Check, Number of Pages

Purpose
Use Number of Pages to specify the number of pages you want to spell-check.

Steps

1 Select Spell Checker in the document or text entry box you want to spell-check, then 
choose Check.

2 Choose Number of Pages.

3 Specify the number of pages that you want to check, starting with the page where the 
insertion point is located.

4 Choose OK.

See Also
Spell Checker Check Menu



Entire Document-Summary Fields
Indexes both text and document summary fields, including subfunctions:    headers, footers, 
footnotes, tables, graphics, and so on. Document summary information is indexed 
separately to increase speed when searching document summary fields.



BIF Edit Insert

BIF Edit, Insert

Purpose
Use Insert to add a group, section, or item to the public .BIF file and to specify its item 
type and item value.

Steps

1 Double-click the BIF Edit icon from the Windows Program Manager.

2 Choose Open Private BIF.
or
Choose Open, specify the BIF you want to edit, then choose Open.

3 Select the feature or application you want to edit.

4 Select the item preceding the place you want to insert an item.

5 Choose Insert.

6 Specify the Group, Section, and Item you want to insert.

7 Choose an Item Type.

8 Specify a value.
or
Select True or False.

9 Choose OK.

See Also
BIF Edit Delete
BIF Edit Edit



Thesaurus

Purpose
Use the Thesaurus to search for synonyms and antonyms of words. Alternatives for a word
are arranged as headwords, references, and subgroups.

References may also be divided into subgroups that correspond to different meanings of 
the headword. Subgroups appear under the headwords.

Steps

1 From Thesaurus, specify a word in the Word text box, then choose Look Up.

2 Double-click headwords to find more related words.

3 Use the arrow buttons to move back and forth between columns.

4 Choose Close.

Choose from the following options for more information:
Dictionary
Edit
History
Help
Replace
Look Up



BIF Edit Override

BIF Edit, Override Private .BIF Values

Purpose
Use Override Private .BIF Values to let items in the public .BIF file overrule the same items 
in the users' private .BIF files. The override flag is designed for supervisors to use when 
running WordPerfect from a network. The flag is usually set after making all necessary 
changes to the WPCNET.BIF file. .BIF file items set to override cannot be permanently 
changed by users.

Steps

1 Double-click the WPCNET Flagging icon from the Windows Program Manager.

2 Choose Open Private BIF.
or
Choose Open, specify the BIF you want to edit, then choose Open.

3 Double-click the group and section of the item you want to flag as an override.

4 Select the item you want to override in users' .BIF files.

5 Select Override Private .BIF Values.

See Also
BIF Edit



Viewer Find

Purpose
Use Viewer Find to highlight all occurrences of the search words or phrases in the file.

Steps

1 Enter any directory dialog box or QuickFinder search results list, then select a text file 
from the file list.

2 Choose View.

3 Right-click inside the Viewer window, then choose Find from the QuickMenu.

4 Type the text you want to find. If you want to find a phrase, enclose it in quotation 
marks.

5 Select Match Whole Word Only if you do not want to find the search text within other 
words, like "cat" in "vacation."

6 Select Case Sensitive if you want to search for capital letters just as you have typed 
them.

7 Press Enter.

8 Choose Find Next or Find Previous to locate other instances of the search text.

9 Choose Close.

See Also
Viewer
Viewing Files



Viewer Font

Purpose
Use Viewer Font to select the font (size and typeface) you want to display in the Viewer.

Steps

1 Enter any directory dialog box or QuickFinder search results list, then select a text file 
from the file list.

2 Choose View.

3 Right-click inside the Viewer window, then choose Font from the QuickMenu.

4 Select a font and point size.

5 Select Bold or Italic if you want the entire Viewer text in bold or italic.

6 Choose OK.

See Also
Printing from the Viewer
Viewer
Viewing Files



WordPerfect Characters

Ctrl+W

Purpose
Use WordPerfect Characters to access characters that do not appear on your keyboard, 
such as phonetic characters and characters in other alphabets. You can insert these 
characters at your insertion point in a document or in some dialog box text boxes. You can
also assign a frequently used character to a specific key on the keyboard. Not all fonts 
include all characters. Excluded characters are represented by a hollow box on your 
screen.

Steps

1 Place the insertion point where you want the character, then press Ctrl+W.

2 Select the character set you want, then select a character.
or
Specify a character number.

3 Choose Insert to insert the character and leave the dialog box open.
or
Choose Insert and Close to insert the character and close the dialog box.

See Also
Assign Characters to Keys



BIF Edit Opening BIF Files

BIF Edit, File, Open Private BIF

Purpose
Use Open and Open Private BIF to open .BIF files.

Steps
To open a BIF file,
1 Double-click the BIF Edit icon from the Windows Program Manager.

2 Choose Open from the File menu.

3 Select the .BIF file you want to edit, then choose Open.

To open your private BIF file,
1 Double-click the BIF Edit icon from the Windows Program Manager.

2 Choose Open Private BIF from the File menu.

See Also
BIF Edit



BIF Edit Save

BIF Edit, Save

Purpose
Use Save to save changes to the .BIF file without exiting BIF Edit. Changes are not saved 
permanently until you choose Save from the File menu or choose Exit and answer Yes to 
save changes.

Steps

1 Double-click the BIF Edit icon from the Windows Program Manager.

2 Choose Open Private BIF.
or
Choose Open, specify the BIF you want to edit, then choose Open.

3 Select the feature or application you want to edit.

4 Make the desired changes in the .BIF file, then choose Save.

See Also
BIF Edit



.BIF file
Binary Initialization File. A file that contains the settings information for WordPerfect 
applications.



Item Type
Specifies the item type, such as ASCII strings, ANSI strings, or Boolean values.



Item Value
Specifies the value of the item, such as numbers, paths, and True/False statements.



group
A top-level folder, equivalent to an application or a major feature.



section
A second-level folder, equivalent to a feature.



item
A third-level entry, equivalent to a feature setting or path.



QuickFinder Indexer Options

QuickFinder, Indexer, Options

Purpose
Use the QuickFinder Indexer Options to specify indexing preferences or index operations.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, choose Indexer, then 
choose Options.

Choose from the following options for more information:
Information
Delete
Rename
Move
Import
Preferences
About

See Also
Individual Index Options
QuickFinder
QuickFinder Indexer



QuickFinder Options

QuickFinder, Options

Purpose
Use Options to display summary fields and the results of the last search, and to refine, 
save, delete, or reuse searches.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, then choose Options.

2 Choose No Summary Fields to hide document summary fields.
or
Choose Default Summary Fields to display a portion of the possible document summary 
fields.
or
Choose All Summary Fields to display all possible summary fields.

3 Choose Last Search results to display the results of the last search.

4 Choose the search query options you want.

Choose from the following options for more information:
Full Word Count Relevancy
No Summary Fields
Default Summary Fields
All Summary Fields
Last Search Results
Clear
Load Search Query
Save Search Query
Delete Search Query

See Also
Expand Word Searches
QuickFinder
Refine QuickFinder Searches



group box
A set of related options in a dialog box, often with its own subtitle.



BIF Edit File Menu

BIF Edit, File

Purpose
Use the options on the File menu to open and save .BIF files and to exit BIF Edit.

Open
Open Private BIF
Save
Exit

See Also
BIF Edit



dialog box title bar
The horizontal bar across the top of the dialog box that contains the name of the dialog box 
and the Control-menu box.



application
Software designed to carry out a certain kind of action or activity, such as word processing, 
electronic mail, or spreadsheet entries. Sometimes called a program.



bullet
A symbol, such as a filled circle, that may precede each item in a list.



check box
A small box next to an option in a dialog box. Clicking an empty check box selects the 
option; clicking a marked check box deselects the option.



command button
A button in a dialog box that carries out a command such as Open, Close, Exit, OK, or 
Cancel. The selected command button is indicated by a dotted rectangle.



Control menu
The menu containing commands that will open, close, maximize, minimize, or restore a 
window or dialog box. You can display a Control menu by clicking the Control-menu box or by
pressing Alt+Spacebar.



Control-menu box
A small rectangular button in the upper-left corner of a window or dialog box. Clicking a 
Control-menu box displays the Control menu; double-clicking the Control-menu box closes 
the window or dialog box. Several windows can be open at the same time, each with its own 
Control-menu box.



document window
The window in which documents are created or edited.



double-click
To press and release the mouse button twice in rapid succession.



filename
The name given to a data file used by applications to perform open and save operations. In 
DOS and Windows applications, filenames can have as many as eight characters with an 
optional extension of as many as three characters. The filename and extension are 
separated with a period.



Saving Files

File, Save or Save As

Purpose
You can save hundreds of files on a hard disk, which works like a filing cabinet with 
directories and subdirectories as file drawers and folders that group similar files. You can 
save files with new names, save them in different directories, or save them in different 
formats. If you do not specify a directory or format, WordPerfect applications save files in 
the current directory and default format.

You should use Save periodically to avoid losing your work if a power or system failure 
occurs. You can also use the Backup features to avoid losing your work.

Steps

1 Choose Save or Save As from the File menu.

2 Select the directory where you want to save the file from the Directories list box or the 
QuickList.
or
Type the full path for the file before the filename.

3 Type a filename for the file.
or
Select the file you want to replace with the saved file.

4 Choose the format you want.

5 Choose Save to save the file in the selected format.

See Also
Opening Files
Save File As Type
Save Format



icon
A small graphics image that represents an application, a command, or a tool. Clicking or 
double-clicking an icon will produce an action.



language code
A two-letter code that represents the language of files such as .MOR, .THS, .TRS, and .ICR 
files.



list box
A box that displays a list of choices. When a list is too long to display all choices, it will have 
a scroll bar, so that you can view additional items.



list button
In dialog boxes, a way to get to another dialog box to select files or change directories. It 
appears as a small file-folder button next to a text box.



macro
A series of commands and menu selections in a file that can be replayed by a few keystrokes
or by a mouse click.



menu bar
The area at the top of a window containing headings for pull-down menu items.



BIF Edit Exit

BIF Edit, File, Exit

Purpose
Use Exit to exit BIF Edit.

Steps

1 Double-click the BIF Edit icon from the Windows Program Manager.

2 Choose Open Private BIF.
or
Choose Open, specify the BIF you want to edit, then choose Open.

3 Select the feature or application whose .BIF file you want to edit.

4 Make the desired changes in the .BIF files.

5 Choose Exit from the File menu.

See Also
BIF Edit



pointer
A symbol that indicates a position on screen as you move the mouse on your desktop.



palette
An on-screen box or window that contains tools, available colors, or possible fill patterns.



parameter
A variable used with a command to indicate a specific value or option.



path
The address that tells a computer where to locate a directory or file on a disk or network. A 
path includes the drive, the root directory, and any subdirectory names that branch from the
root directory.



pop-up definition
A graphic or dot-underlined, colored word that you can click to display a definition or 
explanation.



QuickMenu
A pop-up menu that lists a specific set of items that apply to a particular feature. You can 
open a QuickMenu by placing the mouse pointer over the object and pressing the right 
mouse button. Click the left mouse button to choose the option you want.



radio button
One of a set of buttons found before options in a dialog box. Only one radio button in a set 
can be selected at a time.



root directory
The fundamental directory of a disk, created when the disk is formatted.



scroll bar
The bars on the right side and bottom of the window that let you move vertically and 
horizontally through a document, list, or graphic by clicking the scroll arrows or dragging the
scroll box.



Status Bar
The line at the bottom of a document window that shows information such as the document 
number, page, line, and vertical and horizontal position of the insertion point.



BIF Edit Startup Switches

Purpose
Use Startup Switches in the command line of an application in Windows Program Manager 
to affect how the application operates. Switches in the command line take precedence 
over DOS environment variables, the application environment file, and the shared 
environment file. If there is more than one occurrence of a switch, the last one on the line 
is used.

Steps

1 Choose Properties from the File menu in Windows Program Manager.

2 Specify the Command Line for the application.

3 Use the following startup switches to specify the path for .BIF files and to specify 
whether to use the public or private .BIF file:
/CSLA
/LA
/NI
/NT
/PI
/PN
/SN
/U

4 Choose OK.

See Also
BIF Edit



wildcard
Character used to replace one character (?) or any number of characters (*) in a search 
string. These two characters are conventions in most applications.



window
A method of displaying a document so that many of its elements appear graphically and 
many features are immediately available as on-screen choices. The place where you type 
your documents is called a document window.



application window
The window that contains the operating features of the application, such as the menu bar, 
Toolbar, and document window. Document windows are placed within the application window
and, if your computer has enough memory, you can open as many as nine document 
windows at a time.



title bar
The horizontal bar across the top of each window that contains the name of the window, the 
Control-menu box, and the maximize, minimize, and restore buttons. Sometimes the title bar
also contains Help prompts that give you information about menu items you select.



minimize button
A button that you use to shrink an application window or document window to an icon.



maximize button
A button that you use to enlarge a small application window or document window to its 
maximum size. A window that is smaller than a full-screen window, but not minimized to an 
icon, can also be maximized by double-clicking its title bar.



Toolbar
A feature that contains buttons representing features you use often. You can create your 
own customized Toolbars.



/NI
Specifies the path for the public .BIF file. If you do not specify a value,    the application will 
search the Windows directory for the BIF.



Power Bar
A group of buttons representing frequently used features.



Contents button
A Help button you can use to return to the main Contents screen which helps you quickly 
navigate through specific areas of Help.



Search button
A Help button you can use to search for Help topics by typing keywords.



Back button
A Help button you can use to return to the last topic you opened.



History button
A Help button you can use to display the last 40 Help topics you opened, with the most 
recent at the top of the list. To reopen a topic, double-click it.



Print button
A Help button you can use to print the current Help topic.



Browse buttons
Buttons which display the previous (<<) or next (>>) topic in a series of grouped or 
associated topics. When you reach the first or last topic in the series, the corresponding 
previous or next button is dimmed.



 Hint
You can reduce the size and move the Help window to keep it on-screen while you follow the 
steps.

Choose Always on Top from the Help menu above to display the Help window "on top" of 
other applications, even when it is minimized. Or, size both Help and the application window 
so they do not overlap.



 Hint
Choose an option from the Save File As Type list to save a file in a format other than the 
default for the current application. WordPerfect applications save the file with a default 
extension that identifies the selected file type and format. You can type a period at the end 
of the filename to save the file without an extension, or type your own extension.

Some extensions have special meaning in WordPerfect applications, DOS, or Windows. These
include .ALL, .BAT, .BIF, .COM, .DLL, .EXE, .INI, .PRS, .SET, .WCM, .WPT, and .WWK. Do not 
use these extensions when saving documents unless you have a specific reason for doing so.



/NT
Uses both the public and the private .BIF.



 Hint
Click and drag to select a continuous range of items. You can also click an item at one end of
the range, then hold down the Shift key and click the item at the other end of the range.

Press Ctrl while clicking each item you want to select noncontinuous items. Press Ctrl+/ to 
select all items.

Click inside the file list, then type the first letters or numbers of the filename to move to a 
specific file in a file list sorted by filename, size, or date/time. When the file list is sorted by 
extension, descriptive name, or descriptive type, those items are used in searching.



 Hint
Replace is not available when you run the Thesaurus as a stand-alone application.



/PI
Specifies the path for the private .BIF.



/PN
Specifies the private .BIF name and ignores the extension.



Document Text
Lets you view the body of a document (instead of the Document Summary).



/U
Sets the value for the private .BIF. If you do not specify a value, and Windows does not 
supply a network ID, underscores will be used.



Save Format

Purpose
The Save Format dialog box appears when you attempt to save a document which was 
converted from another format when you opened the document. 

Save Format allows you to save the file in the current default format, the original format, 
or in another format.

Steps

1 Open a document that was saved in a format other than your current default format, 
make any changes you want, then choose Save As from the File menu.

2 Choose the default format or the original format.
or
Choose Other, choose OK, then choose the format you want.

3 Choose OK.

See Also
Managing Files
Open/Save As Setup
Save File as Type
Saving Files



Hex Display
Lets you display a file in hexadecimal mode. You can print any kind of file as a hexidecimal 
document.



Copy to Clipboard
Lets you copy selected text from the Viewer to the Clipboard.



Document Summary
Lets you view the Document Summary of a file (instead of the body of the document).



Word Wrap
Lets you wrap document text in the Viewer window so all text shows regardless of the 
window size.



Opening Files

File, Open

Purpose
Use Open to open as many as nine documents or windows in the same application. Open 
works with documents you have previously saved as files on a hard disk or floppy disk. 
When you want to edit a document that is saved on disk, you need to open a copy of the 
file into a window. The file then becomes active in your computer's memory so that you 
can edit it. The changes you make are not recorded on disk until you save the file again.

Steps

1 Choose Open from the File menu.

2 Select the drive and directory you want to list the files in.

3 Select the file you want.
or
Type the full path, separated by commas, of as many as nine files at one time to open 
multiple files.

4 Choose OK.

See Also
Managing Files
Open a Copy of a File
Saving Files



Spell-Checking

Spell Checker, Start

Purpose
Use Spell Checker to check documents and text entry boxes for misspelled words, 
duplicate words, and irregular capitalization. Spell Checker cannot detect an error caused 
by a correctly spelled word in the wrong context. For example, if you typed "there house" 
rather than "their house," Spell Checker would not detect the error because "there" and 
"their" are valid words and are both spelled correctly.

Steps

1 Open Spell Checker in the document or text entry box that you want to spell-check.

2 Select the options you want from the Check, Dictionaries, and Options menus, then 
choose Start.

3 When Spell Checker selects a word or phrase as a possible error, choose from the 
following options:
Replace
Resume
Skip Once
Skip Always
QuickCorrect
Suggest
Add

4 Choose Yes to exit Spell Checker when a spell-check is completed, or choose Close to 
exit Spell Checker before completing a spell-check.

See Also
Spell Checker
Spell Checker Check Menu
Spell Checker Dictionaries Menu
Spell Checker Options Menu
Spell Checker QuickCorrect



Spell Checker Supplementary Dictionaries

Spell Checker, Dictionaries, Supplementary

Purpose
Use Supplementary Dictionaries to create new supplementary dictionary files that include 
key words and phrases that you want Spell Checker to skip, replace, or display specified 
alternatives for.

You can define a chain of 10 supplementary dictionaries for each spell-check. You can also 
add or delete dictionaries from the chain used for your last spell-check to create a chain 
for the next spell-check.

Steps

1 Open Spell Checker in the document or text entry box that you want to spell-check.

2 Choose Dictionaries, then choose Supplementary.

3 If you are changing the default language selection, choose Language, select the 
language you want, then choose OK.

4 Choose Create, type the name of the supplementary dictionary file you want to create, 
then choose OK.
or
Choose Add, select an existing supplementary dictionary file, then choose OK to add the
dictionary to the chain.

or
Select a dictionary , choose Delete, then choose Yes to remove the dictionary from the chain.

5 Choose Edit to make changes or additions to a selected supplementary dictionary, then 
choose Close.

6 Choose Close to return to the Spell Checker dialog box.

See Also
Language
Spell Checker Dictionaries Menu
Spell Checker Document Dictionary
Spell Checker Add Word/Phrase
Spell Checker Edit Dictionary
Spell Checker Main Dictionaries



Find
Lets you find words or phrases in the document displayed in the Viewer.



Font
Lets you change the font that will show in the Viewer.



Alternatives
Lets you specify a key word or phrase, a list of alternative words, and a comment. Spell 
Checker stops on the key word or phrase, suggests the alternative words as replacements, 
and displays the comment.

Enter the Key Word you want to add, then specify the Alternative words, using Insert to add 
each alternative to the list.

Select an unwanted alternative and choose Delete to remove it from the list.



Auto Replace
Automatically makes replacements defined in selected supplementary dictionaries. Also, 
when you replace one word or phrase during a spell-check, Spell Checker replaces every 
occurrence of the word or phrase in the text being checked.



Beep on Misspelled
Beeps when Spell Checker selects a possible error.



Document
Checks the entire document.



Document Dictionary
Enables or disables the supplementary dictionary that WordPerfect attaches only to the open
document.

When the Document Dictionary is enabled, it is listed as one of the current supplementary 
dictionaries on the To pop-up list in the Spell Checker dialog box. The first dictionary in the 
supplementary dictionary chain is the dictionary selected by default. This is the 
wpspelus.sup or wtspelus.sup file for stand-alone users and the wpxxxxxx.sup (where x's 
represent the user name and language code) for network users.



Duplicate Words
Selects duplicate words (such as "the the") as a single error and suggests that you replace 
the duplicate words with only one of the words.



Exhaustive Checking
Searches for all possible suggestions in languages where limited suggestions are usually 
displayed. This option is disabled in the United States English language and in other 
languages where it is not needed.



QuickCorrect
Replaces the error with the word or spelling defined for QuickCorrect.



Irregular Capitalization
Selects words with capital letters placed inside lowercase words (such as "THe") as possible 
errors. This option is not enabled in all languages.



Number of Pages
Lets you specify how many pages to check, starting with the page where the insertion point 
is located in a document.



Page
Checks the page where the insertion point is located in a document.



Paragraph
Checks the paragraph in which the insertion point is located in a document.



Replacement
Lets you specify a key word or phrase and a replacement word or phrase. Spell Checker 
replaces the key word with the replacement word.

You can also select Auto Replace from the Options menu to have Spell Checker automatically
make the replacements you define in a supplementary dictionary.



Selected Text
Checks only the text that is selected in a document or text entry box (such as the 
Descriptive Name text box in the Document Summary dialog box).



Skip
Lets you specify a word or phrase you want the Spell Checker to skip during a spell-check.



Text Entry Box
Checks the entire text entry box. This option is enabled only when Spell Checker is opened in
a text entry box (such as the Descriptive Name text box in the Document Summary dialog 
box). Word, Sentence, and Selected Text (if you have selected text) are the other options 
enabled when Spell Checker is opened in a text entry box.



To End of Document
Checks text from the insertion point to the end of a document.



Word
Checks the word closest to the insertion point in a document or text entry box (such as the 
Descriptive Name text box in the Document Summary dialog box).



Words with Numbers
Selects words with combined letters and numbers as possible errors. This option is not 
enabled in all languages.



Text Only
Indexes only textual information without summary fields or other subfunctions.



 Hint
Filling in more than one field performs a logical AND operation.



 Hint
Make sure you have documents with document summary information.



 Hint
If you choose No Summary Fields from the Options drop-down list to collapse the QuickFinder
dialog box, all document summary fields are cleared and are not used in the search.



 Hint
Updating the index with new or modified files speeds up the indexing process.



 Hint
Index level refers to the amount of information stored in the index, that is, which document, 
paragraph, line, or sentence the word is contained in. Indexing at the larger levels 
(document, hard page, or page) decreases the size of the index. Indexing at the smaller 
levels increases the index size but allows you to find multiple words within the same line, 
sentence, or paragraph much faster.



 Hint
If a query has been saved with document summary fields (expanded mode), then the 
summary fields display when you load the query.



Filename Only
Indexes only DOS filenames.



Summary Fields Only
Indexes only document summary fields.



Viewer Go To Page

Viewer, right-click, Go To Page

Purpose
Use Viewer Go To Page to view multiple-page fax files.

Steps

1 Enter any directory dialog box or QuickFinder search results list, then select a text file 
from the file list.

2 Choose View.

3 Right-click inside the Viewer window, then choose Go to Page from the QuickMenu.

4 Specify the page number you want to view.

5 Choose OK.

See Also
Viewer



 Hint
A special icon (WPCNET Flagging) is set up during a Server Install to launch the BIF Editor. 
The WPCNET Flagging icon starts the BIF Editor and opens the public .BIF file named 
WPCNET.BIF. The administrator can view and change settings in the public .BIF file which will 
take effect for all users of the network copy of WordPerfect.



 Hint
Use the WPCNET Settings icon to set directory paths pointing to shared network directories 
from within WordPerfect. Use the BIF Editor to edit paths that require relative drive settings.



 Hint
If a language that you often use contains special characters (WordPerfect Characters), you 
can create a keyboard for that language by mapping those characters to the keys of your 
choice.



/CSLA
Makes the names hashing for the private .BIF file case-sensitive.



/LA
Determines your Login Alias and the value hashed for your private .BIF file name.



/SN
Suppresses name hashing, and allows you to use a WPCSET.BIF file for your private .BIF file 
instead of XXXXYYYY.BIF where "XXXX" is the first four letters of your Login Alias and "YYYY" 
is the hashed value.



Cascade

Purpose
Use Cascade to view as many as nine open document windows at the same time. Cascade
overlaps the windows.

Steps

1 Choose Cascade from the Window menu.

See Also
Tile



Control Menu

Purpose
Use the options on the Control Menu to position, size, close, and switch application 
windows. Double-click the control-menu box, then choose an option from the Control 
Menu.

Restore
Move
Size
Minimize
Maximize
Next
Exit
Switch To



document
A file (drawing, text, slide show, spreadsheet, and so on) created in a WordPerfect 
application.



Close

Control Menu, Close

Purpose
Use Close to close a document or to exit an application.

Steps

1 Choose Close from the Control menu.

2 Choose Yes to save changes and exit the document or application.

See Also
Switch To



keyboard layout
A group of shortcut keys saved together in a file. In many WordPerfect applications, you can 
create customized keyboard layouts.



Maximize

Control Menu, Maximize

Purpose
Use Maximize to enlarge a window to full size.

Steps

1 Activate the window you want to maximize, then choose Maximize from the Control 
menu.
or
Double-click the title bar of the window you want to maximize.Click the Maximize button
(the up-arrow button on the window title bar).

See Also
Minimize



Minimize

Control Menu, Minimize

Purpose
Use Minimize to reduce a window to an icon.

1 Activate the window you want to minimize, then choose Minimize from the Control 
menu.
or
Click the Minimize button (the down-arrow button on the window title bar).

See Also
Maximize



Move

Control Menu, Move

Purpose
Use Move to relocate a window on the screen.

Steps

1 Activate the window you want to move, then choose Move from the Control menu. Use 
the arrow keys to move the window to a new location, then press Enter.
or
Drag the title bar to the new location.

See Also
Size



Next

Control Menu, Next

Purpose
Use Next to scroll through open document windows.

Steps

1 Choose Next from the Control menu.

See Also
Switch To



Restore

Control Menu, Restore

Purpose
Use Restore to return a window to its previous size and position.

Steps

1 Activate the window you want to restore, then choose Restore from the Control menu.
or
Click the Restore button (the double-arrow button on the window title bar).

See Also
Maximize
Size



Size

Control Menu, Size

Purpose
Use Size to modify the size of a window.

Steps

1 Activate the window you want to size, then choose Size from the Control menu. Use the 
arrow keys until the outline of the window is the size you want, then press Enter.
or
Place the pointer on the window border (the pointer becomes a double arrow), then 
drag the pointer to the size you want.

See Also
Maximize
Move
Restore



Switch To

Control Menu, Switch To

Purpose
Use Switch To to activate other applications without exiting the current one.

Steps

1 Choose Switch To from the Control menu, select the application you want, then choose 
Switch To.
or
Press Alt+Tab.

See Also
Next



Tile

Purpose
Use Tile to view as many as nine open windows at the same time. Tile places the windows 
side by side.

Steps

1 Choose Tile from the Window menu.

See Also
Cascade



window border
The outside border of an application window or a tiled or cascaded document window. Drag 
the border to size the window.



Invert
Lets you change the display of fax files from black on white to white on black and vice versa.



Rotate
Lets you rotate the current page of a fax file 180 degrees.



Zoom
Lets you change your view of a fax, cursor, or icon file. You can enlarge faxes up to 200% or 
reduce them down to 50%. You can enlarge cursor and icon files up to 800%.

Zoom does not actually size the image, it only changes your view.



Print
Lets you print all or part of a text or hex file, select printers, change fonts, and specify 
margins.



Printing from the Viewer

Viewer, right-click, Print

Purpose
Use Print to print all or part of a text or hex file, select printers, change fonts, and specify 
margins.

Steps

1 Enter any directory dialog box or QuickFinder search results list, then select a text file 
from the file list.

2 Choose View.

3 Right-click inside the Viewer window, then choose Print from the QuickMenu.

4 Specify the pages you want to print.

5 Choose Setup to select a printer or change printer options, then choose OK.

6 Select display Font to print using the current display font.
or
Select Specific Font, choose Change, select a font and a point size for printing, then 
choose OK.

7 Select Inches or Centimeters, then specify the margins for printing.

8 Choose Print.

See Also
Viewing Files



Refine QuickFinder Searches

QuickFinder, define a search

Purpose
Use the operators and switches from Operators lists to create and refine complex 
searches. Search operators and switches apply to all text that follows in the Search For 
text box.

            Search switches should be placed before the search terms they will affect. Use
parentheses to group search terms, switches, and operators. Search operators bind in 
the following order if no parentheses or switches are used:    NOT, FOLLOWED BY, AND, 
OR.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, choose Operators, then 
choose options to refine your search.

2 Select the category you want, then choose the operator, switch, or document summary 
field you want to use.

These are the search operators you can use:
And (&)
Followed By (..)
Group ()
Not (!)
Or (|)

These are the matching operators you can use:
Zero or More Characters (*)
Any Single Character (?)
Case Insensitive
Case Sensitive
Prefix Mode On and Off

These are the switches you can use for word proximity searches:
Document
Field
Hard Page
Line
Page
Paragraph
Phrase ("")
Record
Sentence
Within # Words

These are the switches you can use to search specific parts of a document:
Entire
First Page
Summary Only



Text Only

You can also search any Summary Fields included in the document.

These are the Other operators you can use:
Scan Off
Wildcard Off and On

3 Type the word or phrase you want to search for. Place the switches after the words they 
affect, and use parentheses to group a search query.

4 Choose Insert to insert the operator or switch and leave the dialog box open.
or
Choose Insert and Close to insert the operator or switch and close the dialog box.

5 Choose Find.

See Also
Expand Word Searches
QuickFinder
QuickFinder Indexer
QuickFinder Search For



And (&)

Appears as &, AND, or a space.

For example, mountain & goat, mountain AND goat, and mountain goat all find 
documents containing the search terms "mountain" and "goat."



Any Single Character (?)

Appears as ?.

For example, mountain? finds all documents containing the word "mountain" plus a single 
character, like "mountains."



Case Sensitive

Appears as /Case.

Finds search terms that match upper- and lowercase pattern of the search terms. For 
example, /Case Zoo finds "Zoo," but not "zoo." 



Document

Appears as /Document.

Finds search terms in the same document (this option resets all other levels).



Entire

Appears as /Entire.

Finds search terms in all document text and in all document summary information. This is 
the default switch.



Field

Appears as /Field.

Finds search terms in the same field. Use this option with database-oriented files such as 
Merge files. Works on non-index searches only.



First Page

Appears as /FirstPage.

Finds search terms only in the first page of the document text and in the document 
summary.



Followed By (..)

Appears as ...

For example, mountain .. goat finds document that contain both search terms, with 
"mountain" before "goat" somewhere in the document.



Group ()

Appears as ( ) with search text in between.

For example, (/FirstPage (/Line subject reorganization) "John Smith" companyX) 
finds documents with the first page containing the search terms "subject" and 
"reorganization" on the same line, with "John Smith" and "companyX" appearing on the 
same page.



Hard Page

Appears as /HardPage.

Finds search terms in the same section of a document, bounded by hard pages.



Line

Appears as /Line.

Finds search terms on the same line of the document, as currently formatted on disk.



Not (!)

Appears as ! or NOT.

For example, mountain ! goat and mountain NOT goat both find documents containing 
the word "mountain" but not the word "goat."    Documents that contain both are not 
included.



Case Insensitive

Appears as /NoCase.

Finds search terms that match the search terms, ignoring upper- and lowercase. For 
example, /NoCase Zoo finds both "Zoo" and "zoo."    This is the default setting.



Or (|)

Appears as | or OR.

For example, mountain | goat and mountain OR goat both find documents containing 
"mountain" or "goat" or both search terms.



Page

Appears as /Page.

Finds search terms on the same page of the document, as currently formatted on disk.



Paragraph

Appears as /Paragraph.

Finds search terms on in the same paragraph of the document.



Phrase ("")

Appears as " " with a search phrase between.

Finds phrases, exactly as you type them. For example, "Dr. Jane Smith" finds Dr. Jane 
Smith, but not Dr Jane Smith or Dr. J. Smith.



Record

Appears as /Record.

Finds search terms in the same record. Use this option with database-oriented files such as 
Merge files. Works on non-index searches only.



Sentence

Appears as /Sentence.

Finds search terms in the same sentence of the document.



Summary Fields

Appears as /Summary=name, /name, or /Summary=n.

Finds search terms in the document summary field you specify. The name of the field 
replaces the field number or name in the switch pattern. For example, /Summary=Typist 
Shauna finds documents with "Shauna" in the Typist field of the Document Summary.



Summary Only

Appears as /Summary.

Finds search terms in all document summary information, but not in the document itself.



Text Only

Appears as /Text.

Finds search terms in all document text, excluding headers, footers, and document 
summaries.



Within # Words

Appears as /#.

Finds search terms that are within a certain number of words of each other. For example, /2 
finds search terms within two words of each other.



Zero or More Characters (*)

Appears as *.

For example, mountain* finds documents containing all variation of words that begin with 
"mountain," with or without other characters. This includes "mountain," "mountains," 
"mountainous," and so on.



Additional Information about QuickFinder

Speeding Up Indexing
The QuickFinder Indexer is one of the fastest indexers in the industry. However, there are 
ways to optimize indexing time. Here are some suggestions that can help you increase the
speed of creating QuickFinder indexes:

          Select a broad level of indexing for Index Level, such as Document or Paragraph.

          Launch QuickFinder File Indexer in standalone mode (while no other programs are 
running).

          Create an index that contains only document Summary Fields.

          Exclude as many document types as you can.

          Do not include numbers.

          Index only WordPerfect documents if you have a mix of WP and non-WP documents.

          If you are indexing a large number of small files, change the show indexing progress 
to a larger number.

Indexing with Startup Options
You can use the following startup options to automate updating QuickFinder indexes:

          /ra:    Rebuilds all indexes listed in the QuickFinder Index Names list box.

          /r-[long index name]:    Rebuilds only the specified index.

          /ia:    Updates the specified index with new or modified files.

          /i-[long index name]:    Updates the specified index with new or modified files.

          /g-[long index name] and /ga:    "Smart update." If the .inc file is 10% the size of 
the .idx file, it will rebuild the index.    If it is smaller than 10%, it will update the index.

Because the Command Line is case sensitive, entries must be typed exactly. You can 
specify more than one index name, as long as you separate them with a comma and a 
space (for example, c:\wpc20\qfwin20.exe /r-newsletters, 1982 magazines).

QuickFinder Log Files
A QuickFinder log file is created when QuickFinder attempts to index a file that is open or 
password protected. The log file has the same name and directory location as the 
QuickFinder index file, but has a .LOG file extension.

Saving QuickFinder Indexes
QuickFinder saves indexes after every generation. You name the file when you create the 
index, and QuickFinder stores the indexes as files that use a .IDX extension (for example, 
BRIEFS92.IDX). Incremental index files receive a .INC extension. Error messages are stored
in a file with a .LOG extension. You can specify the directory where indexes are stored 
using the Location for Index Files option on the QuickFinder Indexer Preferences dialog 



box.

Running QuickFinder as a Standalone Application
You can run QuickFinder independent of any other WordPerfect application by double-
clicking the QuickFinder icon in the Windows Program Manager.

See Also
QuickFinder
QuickFinder Indexer



 Hint
You can use wildcard characters to include specific types of files. For example, typing c:\
october\*.shw will include all files in the OCTOBER subdirectory of the C: drive with the 
extension .SHW; typing c:\october\*.* includes all files in the OCTOBER subdirectory.



Viewer Info

Viewer, right click, Viewer Info

Purpose
Use Viewer Info to display viewer capabilities by viewer and file type.

Steps

1 Right-click inside the Viewer, then choose Viewer Info.

2 Select Viewer to display available viewers.
or
Select File Type to display available file types.

3 Select the viewer you want to display the file types it can view.
or
Select the file type you want to display the compatible viewers.

4 Choose OK.

See Also
Viewing Files



Additional Information about Viewer

Using the Viewer
The Viewer has been designed to:

          Help you find a specific file quickly, especially when you know something about the 
content of the file.

          Help you create documents by copying parts of the document you are viewing into 
another document.

          Provide viewing capabilities for files located by a QuickFinder search. The Viewer 
highlights the word or phrase searched for and displays the document at the first 
occurrence of the search text.

          Let you assign viewers to specific types of files.

          Let you look at or hear a file before you use it in a document.

          Let you print all or part of a file without retrieving it into a document.

If a Viewer window is displayed, you can select a filename in any list box to view the 
contents of that file.

How the Viewer Works
The Viewer provides a quick display of the contents of a file. The Viewer can display text, 
graphics, codes, and faxes. It also plays audiovisual and sound files.

To enhance its speed, the Viewer has been designed to display document contents, but 
not all of the formatting. Thus, the Viewer does not provide full WYSIWYG viewing of file 
contents. Files display both text and graphics in the Viewer window. If a file you are 
viewing contains only graphics, you can view them if they are in a supported graphics 
format.

Types of Files the Viewer Displays

          WordPerfect documents (4.2, 5.x, and 6.0 formats)

          WordPerfect graphics files (.WPG)

          Sound files (Waveform, MIDI)

          Various non-WordPerfect document and spreadsheet files (including documents 
created in Word for Windows, AmiPro, and Lotus 123 spreadsheets)

          Various graphics file formats

          Fax files (DCX and some TIFF formats)

          List of files contained in a ZIP file

          Cursor and icon files



See Also
Viewer
Viewing Files



 Hint
The Language dialog box lists all of the languages WordPerfect currently supports. If 
WordPerfect adds support for a language, and you install the language module for that 
language, you can specify the two letter language code for the new language by typing the 
code in the Language text box.



 Hint
When you select a language, a WordPerfect application inserts the language code [Lang:xx]. 
The letters xx represent the two letter code indicating the language (such as CA for Catalan 
and DK for Danish). WordPerfect applications use the new language code from that point on 
in the document or until they reach another language code. If you select text before 
selecting a language, a code for the new language is placed at the beginning of the 
selection, and a code for the previous language is placed at the end of the selection. For 
example, you can place different language codes around specific portions of text and have 
your WordPerfect application spell-check those sections using the specified languages.



 Hint
The Main Dictionary in Spell Checker comes in two types, a word list or an algorithmic 
dictionary. The type of dictionary you have depends on the language you are using. A word-
list based dictionary checks for correct spelling by comparing each word in your document 
with the dictionary word list. An algorithmic dictionary uses rules instead of words to check 
spelling.



Additional Information about Macro Facility

Macro Language
The macro language is a command-based language. This means that the WordPerfect 
application records the results of keystrokes or mouse selections instead of recording the 
keystrokes themselves. For example, instead of recording each keystroke involved in 
changing the top margin of your document to 2, the application simply records the 
command MarginTop(2.0). These commands are called product commands.

The macro language also includes programming commands. These commands let you 
create macros that can respond to user input.

Compiling a Macro
A macro compiler is used to compile or translate macros so that applications can play 
them. Macros in WordPerfect applications are compiled when you play or record them.

If you receive an error message while the macro is compiling, you can choose Cancel 
Compilation to close the dialog box, or you can choose Continue Compilation to check for 
other errors that may be in the macro. In either case, the macro wont play; all errors must 
be corrected first.

Troubleshooting Macro Problems
The compiler is a useful tool for troubleshooting macro problems. If the compiler locates 
an error, a dialog box containing general information about the problem displays. The 
macro compiler, however, can only make a best guess as to what the macro is actually 
designed to accomplish. As a result, errors given by the compiler sometimes serve as 
direction to, rather than specific identification of, the reported problem.

Macros Online Help
WordPerfect applications include an online macros manual. To access the manual, choose 
Search for Help On... from the Help menu, then type macro. The online manual contains 
information about macro commands and their syntax, with additional instructions and 
examples for using macros.

Macro Feature Bar
The Macro Feature Bar in WordPerfect 6.0 for Windows provides on-screen access to the 
Command Inserter and other macro functions.

Command Inserter
The Command Inserter helps you to insert macro product and programming commands 
into your macros.

Product commands perform functions that let you use WordPerfect applications features in
your macros. Many product commands require you to specify parameters and value set 
members; these give WordPerfect applications information about options to choose in 
dialog boxes and whether certain features (such as the Ruler Bar) should be displayed or 
hidden. You can use the Command Inserter to specify the commands quickly.

While product commands allow you to use WordPerfect applications features, 
programming commands allow you to control how those features act and interact. For 
example, you can use programming commands to request information from the user or 
specify that part of a macro runs several times. The Command Inserter displays the proper



syntax of the programming command you select.

When you use the Command Inserter, you can spend less time typing and worrying about 
spelling errors--you simply choose the commands and parameters you want from the list 
boxes and insert them into your macro.

Macro Commands and Syntax
If you create macros by choosing items with the mouse, the commands are automatically 
inserted in the correct format.

In order for macros you type from the keyboard to work properly, macro commands and 
their elements must be arranged in the correct order. This arrangement is called syntax. 
To be syntactically correct, each macro command must be spelled correctly and must 
include all of the required parameters and the necessary separators in the correct order.

Macro commands consist of three parts:    a command name, parameters, and separators.

Command Name
The command name indicates which feature the command activates. Sometimes the 
name is all that is necessary to perform a complete action. For example, FileOpenDlg() is a
complete macro command because WordPerfect does not need any additional information;
the command name itself opens the File Open dialog box.

Example:    FileOpenDlg()

Parameters
If a WordPerfect application needs more information than is provided by the command 
name alone, parameters are required. The command name represents the feature. 
Parameters represent aspects of the feature you can change or selections you can make. 
For example, the Backup command requires one parameter that indicates whether you 
want Automatic Document Backup turned on or off. Parameters are always enclosed in 
parentheses.

Example:    Backup(On!)

Separators
Some macro commands require several parameters. Parameters generally need to be 
placed in the correct order (except when you specify parameter names) and must be 
separated properly. Semicolons (;) are used to separate individual parameters, and an 
entire string of parameters must be enclosed in parentheses. Groups of repeating 
parameters are also enclosed in braces ({}).

For more information, see Expressions and Variables in the online macros manual. To 
access the macros manual, choose Macros from the Help menu.

See Macro Commands Index in the online macros manual for the required syntax and a 
description of each parameter for all WordPerfect macro commands.

Typing Macro Commands Yourself
Since you do not need to use a macro editor to create or edit WordPerfect macros, you can
insert macro commands by typing them in a blank document. When you save a macro, 
remember to give it a .WCM extension.

You can type commands into a macro that is saved in a file or in a template.



If you want to improve the readability of a macro, you can format it so that it includes 
tabs, spaces, and even font or text appearance changes. Formatting the macro will not 
affect how it works. For example, WordPerfect records the following macro in this format:

PosDocBottom()
Type(Sincerely)
HardReturn()
HardReturn()
HardReturn()
HardReturn()
Type(Ms. Sharon Openshaw)
HardReturn()
Type(Vice President, Marketing)

However, if you type in the commands yourself or edit the existing macro, you can format 
it as follows:
PosDocBottom()

Type (Sincerely)

HardReturn()
HardReturn()
HardReturn()
HardReturn()

Type (Ms. Sharon Openshaw)

HardReturn()

Type (Vice President, Marketing)

See Also
Compiling Macros
Converting Macros
Editing Macros
Macro Facility
Recording Macros
Using Macros



 Hint
Main dictionaries are *.MOR files. Supplementary dictionaries are *.SUP files. International 
dictionaries are *XX.MOR files where XX indicates the language. They are included as part of
a language module. If a language module is not available for a language you want to use, 
you can create your own supplementary dictionary.

To purchase an international language module or the Spell Utility to convert your 5.1/5.2 
*.MOR files and supplementary dictionaries to a compatible format, contact    your local 
WordPerfect affiliate or authorized reseller.



 Hint
If you try to open a file that was created in a format other than the format the current 
application uses, the Convert File Format message box appears. Choose OK to convert the 
file.

If a WordPerfect application cannot convert the file, an error message will inform you that 
the file format is unknown. If this occurs, you may want to use the original program to save 
the file in DCA/RTF or RTF format. If neither of these formats is available, you can save the 
file as an ASCII (DOS) text file. However, some formatting features in your file may be lost 
when you open it into the current application.



 Hint
WordPerfect applications provide more than 1,500 characters and symbols, which are 
grouped into fifteen character sets. Each numbered character set contains a certain type of 
character. For example, character set 0 contains ASCII characters, and character set 8 
contains Greek characters. Most of these characters are listed in the WordPerfect Characters
dialog box.

Each character in a set is also numbered. The combination of the set number and the 
character number identifies each character. For example, the Italian currency symbol is in 
character set 4, and is number 61. Therefore, that character's number is 4,61.



Compiling Macros

Macro Facility, Macros, Compile

Purpose
Use Compile to compile or translate macros so that applications can play them. Macros in 
WordPerfect applications are also compiled when you play or record them.

Steps
To compile a macro,
1 From the Macro Facility, choose Compile from the Macros menu.

2 Specify the filename of the macro you want to compile.

3 Choose Compile.

To stop compiling a macro,
1 While compiling a macro, choose Stop compile from the Macros menu.

See Also
Converting Macros



Graphic Conversion
Lets you convert graphics for viewing. If you choose Disable Graphics Conversion from the 
QuickMenu, you can use the conversion button in the Viewer to convert individual graphics 
files for viewing.



 Hint
The language and country as listed on the outside of your WordPerfect applications package 
is the package language. Screen elements (dialog boxes and menus), dates, and tables 
display in this language.

To change package languages, use the /LXX startup command (where XX is the two letter 
language code) when you start your application, or manually add "Resource Language=XX" 
(where XX is the two letter language code) to your WIN.INI file. If you do not specify a 
resource language, the application searches the path directories and uses the first 
YYYYYYXX.DLL it can find (where YYYYYY is the program's acronym and XX is the specified 
language).

If you are using a language with a non-Roman alphabet (such as Greek, Cyrillic, or Hebrew), 
choose the correct character map to greatly reduce document size.



Editing Macros

Purpose
Use the Editor you specified in the Options dialog box to edit existing macros.    You can 
also create new macros by typing a new filename. Use the Macro Command Inserter to 
access WP macro commands or edit existing ones.

Steps
To edit a macro,
1 In the Macro Facility, choose Edit from the Macros menu in the Macro Facility.

2 Specify the name of the macro you want to edit, then choose Edit.

3 If necessary, choose Convert to convert the macro for editing.

The macro editor you specified in the Options dialog box launches with the macro you 
chose open and ready to edit.

4 Exit the macro editor you are using when you finish editing the macro.

To insert a macro command with the WP Command Inserter,
1 Open WordPerfect 6.0 for Windows.

2 Choose Macro from the Tools menu, then choose Macro Bar to display the Macros 
Feature Bar.

3 Choose Command Inserter.

4 Choose the type of command you want to insert.

5 Choose the command you want to insert from the list.

6 Specify the parameter you want to use.

7 Select the member you want to use, then specify any additional parameters you need.

8 Choose Insert to insert the completed product or programming command into your 
macro.

9 Choose Close to return to the document window.

See Also
Compiling Macros
Converting Macros
Macro Facility
Macro Facility Options
Recording Macros
Using Macros



 Hint
The WordPerfect application you are using automatically inserts the Application command 
when you record a macro. This command tells the Macro feature that, unless otherwise 
specified, commands in the macro should be sent to the that WordPerfect application and 
not to another application.

If you type a name that does not exist, the Editor you have chosen opens to a blank 
document and gives it that filename.



Exclude Files
Ignores all specified file types. All files with .EXE, .COM, and .DLL extensions are excluded by
default.



Expand Browse Dialog
Lets you specify how the Create and Edit Index dialog boxes appear. If you select Expand 
Browse Dialog, the Filename, Drives, and Directories display each time the dialog box is 
opened. (Applies to all indexes.)



Extended Characters in Non-WP Documents
Lets you specify how extended characters in documents other than WordPerfect formats are 
treated in the index. If you are indexing a document created in Windows, choose Interpret as
ANSI; if you are indexing a document created in DOS, choose Interpret as ASCII. If you have 
both or are unsure, select Exclude.



Include Numbers in Index
Indexes numbers as well as letters.



Index Contains
Lets you specify how much of a document to index.



Index Level
Lets you specify an area to search for word patterns (for example, on the same line, or in the
same paragraph).



Index WordPerfect Documents Only
Indexes only WordPerfect 5.1/5.2 and 6.0 documents (but not WordPerfect 4.0 documents).



Location for Index Files
Lets you specify the default location for index files. (Applies to all indexes.)



Regenerating Indexes

QuickFinder, Indexer, Create or Edit, Generate

Purpose
Use Index All Files regenerate indexes by indexing all the files in the index again.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, then choose Indexer.

2 Select the index you want to update from the Index Names list box.

3 Choose Generate, select Index All Files, then choose OK.

4 Choose OK when the index is complete.

5 Choose Close, then choose Close again to return to your document.

See Also
Updating Indexes



Show Indexing Progress Every x Files
Lets you specify how many files will be indexed before the progress line shows change. 
(Applies to all indexes.)



Updating Indexes

QuickFinder, Indexer, Create or Edit, Generate

Purpose
Use Update Index with New or Modified Files to add new information to the most recently 
generated index file.

Steps

1 Open QuickFinder stand-alone or from a directory dialog box, then choose Indexer.

2 Select the index you want to update from the Index Names list box.

3 Choose Generate, select Update Index With New or Modified Files, then choose OK.

4 Choose OK when the index is complete.

5 Choose Close, then choose Close again to return to your document.

See Also
Regenerating Indexes



Delete QuickList Item

QuickList, Delete Item

Purpose
Use Delete Item to remove an item from a QuickList.

Steps

1 Enter any directory dialog box.

2 Select the item you want to delete.

3 Right-click on the QuickList, then choose Delete Item.

4 Choose Yes.

See Also
Add or Edit QuickList Item
QuickList



counter box
A box in which you specify a number by typing or by using the incrementor/decrementor 
buttons.



Go to Page
Lets you specify the page number you want to view.



Next Page
Lets you move to the next page of the fax file.



Previous Page
Lets you move to the previous page in the fax file.



 Hint
If the .BIF file you are editing is read-only, a dialog box will appear giving you the option of 
exiting and retrying, or continuing. If you decide to continue, you can edit a copy of the 
public .BIF, which will be stored in the Windows directory. The original .BIF will remain 
unchanged.



UNC Drive Mappings

Purpose
When your computer is part of a network, use Universal Naming Convention (UNC) drive 
mapping formats anywhere you specify a filename.

Steps

1 Enter any directory dialog box or QuickFinder search results list.

2 Specify the filename of the file, using the following drive mapping conventions:

Format Syntax
UNC
Acceptable

\\Server\Volume\Dir\Dir etc...
//Server/Volume/Dir/Dir etc...

Novell
Acceptable

Server/Volume:Dir\Dir etc...
Server\Volume:Dir/Dir etc...

3 Choose OK.

See Also
Managing Files
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